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Introduction

For those seeking an image editing application with broad capabilities, but don’t require an 
“industrial strength” (not to mention expensive) solution, Pixlr Editor is the ideal choice.

A huge benefit this program offers is that it’s free! There are no discs or downloads to 
purchase, nor are there any subscriptions that must be purchased month after month  
(or year after year, for that matter).

Aside from being free to use, Pixlr Editor offers the perfect balance of convenience 
and power. Because it’s browser-based, it’s easy to launch from any computer with at 
least 2GB of RAM and a reliable Internet connection. There’s nothing to download, so just 
launch it and you’re ready to go. Pixlr Editor is easy to use for minor image editing tasks, 
yet powerful enough to handle more complex work.

Pixlr Express is a lightweight web-based application designed primarily for 
performing basic editing tasks and applying effects to images. If you’d like to try this  
easy-to-use editor, visit https://pixlr.com/express/.

Who This Book Is For
This book is for anyone with little to no image editing experience seeking a robust 
application without a high price tag (or an extremely steep learning curve). It’s for the 
family archivist who wants to digitally retouch and restore old family photos. It’s for 
budding digital photographers who want to improve the quality of the images they 
capture. It’s for the small business owner who needs to edit images for digital marketing 
materials or company publications.

I believe this book can be especially useful to art and photography teachers with the 
desire to introduce students to entry level image editing. For some of these educators, 
teaching digital image editing may now be out of the question because of school budget 
issues. They are often too tight to allow software subscriptions or purchases.

Because Pixlr Editor is free to use, this could be a game-changer for those teachers. 
This program works on any platform (Windows, Mac OS, or Linux/UNIX) that has an  
up-to-date browser, sufficient RAM, and a reliable Internet connection.

It should be noted that toward the end of this book’s production, Pixlr Editor was 
acquired by 123RF from Autodesk. According to the acquisition announcement, Pixlr 
Editor will revised and updated on an ongoing basis.

To keep this book as up to date as possible, a supplemental PDF titled Beginning 
Pixlr Editor Updates can be obtained from the Source Code/Downloads tab from this 
Apress page: http://www.apress.com/9781484226971.

It will be revised as needed every few weeks.

https://pixlr.com/express/
 http://www.apress.com/9781484226971
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How This Book Is Structured
This book is written for primarily for novices. For the totally uninitiated, there are 
supplemental aids included as downloadable PDF documents, as well as practice JPEG 
and PXD (the native Pixlr format) images. The supplemental learning materials are 
included for the benefit of beginners with no experience in image editing. The Tools 
Tryout Guide and Practice Images provides instructions for hands-on learning in the use 
of each tool. The Beginner’s Guide to Layers will get beginners familiar with the various 
roles layers play in image editing.

Part I of this book acquaints readers with topics such as the launch screen, the 
workspace, palettes, the menu bar, and various tools (to name a few). Part II contains 25 
step-by-step tutorials spanning Chapters 4 through 10.

For those readers who are busy teachers, there are chapter tests and an answer key 
available for download as PDF documents, which you can administer to your students 
(saving you the time and hassle of preparing tests yourself).

 ■ Note Pixlr editor is quite similar to Adobe Photoshop in many of its core functions. 
For students who will study image editing after high school (and because taking Photoshop 
classes will most likely be required), many of the skills acquired learning Pixlr editor will be 
very useful and will help reduce the learning curve in learning Photoshop.

All of the downloadable supplemental material, tests, answer key, and practice images 
can be can be obtained from the Source Code/Downloads tab from this Apress page: 
http://www.apress.com/9781484226971.

Macintosh Users
The tutorials in this book use the Windows (and Linux/UNIX) keyboard shortcuts.  
If you are a Macintosh user, the Mac equivalents of these Windows counterparts are 
listed in Table 1.

http://dx.doi.org/10.1007/978-1-4842-2698-8_4
http://dx.doi.org/10.1007/978-1-4842-2698-8_10
http://www.apress.com/9781484226971
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Improving with Practice
The tutorials in this book help you learn a great deal about photo editing; they provide 
step-by-step instructions to help you get acquainted with the mechanics of Pixlr Editor, 
as well as image editing basics. It’s a good idea to use Pixlr Editor on a regular basis to 
hone the skills that you learn from studying this book. Just like any other skill, to get good 
at it takes a lot of practice. Old family photos with minor damage can provide you with a 
great deal of practice, and you’ll help preserve your family history in the bargain.

If you like creating graphics, it’s possible to spend countless hours creating raster 
illustrations using Pixlr Editor. If you’ve never done any image editing before, you might 
just find it to be so much fun you can’t pull yourself away!

Table 1. Mac/Windows Keyboard Shortcuts Equivalents

Function Mac OS Windows

Cut to Clipboard Command+X Control+X

Copy to Clipboard Command+C Control+C

Paste from Clipboard Command+V Control+V

Undo Command+Z Control+Z

Redo Command+Y Control+Y

Free Transform Command+T Control+T

Select All Command+A Control+A

Deselect All Command+D Control+D

Contextual Menus Control-click Right-click

Print Command+P Control+P

Define Brush Command+K Control+K



PART I

Getting to Know Pixlr 
Editor



3© Phillip Whitt 2017 
P. Whitt, Beginning Pixlr Editor, DOI 10.1007/978-1-4842-2698-8_1

CHAPTER 1

An Overview of Pixlr Editor

This chapter covers several basic but important aspects of Pixlr Editor that will be 
especially useful for those new to image editing. This chapter covers the following topics:

•	 Launching Pixlr Editor: In this section, we’ll take a look at 
launching the application for the first time.

•	 The Pixlr Editor Workspace: This part essentially provides 
an overall look at the interface and where all of the tools and 
functions in Pixlr Editor are located.

•	 Pixel-Based Images Explained: Pixlr Editor works with pixel-based 
(or raster) images, which will be covered in this portion.

•	 File Formats: In this section, we’ll take a look at the types of file 
formats Pixlr Editor can open and save, as well as the differences 
between them.

•	 Opening Images: This part provides guidance in how to open 
images in Pixlr Editor.

•	 Saving Images: Shows where to save your images, and the file 
format options available to save them as.

 ■ Note If you’re new to image editing, I suggest following along on your computer after 
launching Pixlr Editor to become better acquainted with the start screen, workspace, and 
opening/saving files.

Launching Pixlr Editor
The fact that Pixlr Editor works in web browsers makes it very convenient to access and 
simple to launch. However, there are a few things to keep in mind:

•	 The Adobe Flash plug-in must be installed on your system for 
the application to work. It’s highly likely that it’s already on your 
computer, but if it’s not, you can get it free by following this link: 
https://helpx.adobe.com/flash-player.html.

https://helpx.adobe.com/flash-player.html
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•	 A fast, reliable Internet connection is required.

•	 Pixlr Editor works in most web browsers, but it may not work in 
older, outdated versions. For best results, make sure you have the 
latest version installed on your system.

•	 Your computer should have sufficient RAM installed (I suggest a 
minimum of 2GB).

There’s more than one path to launch the application, but the most direct way is 
to use the following URL: https://pixlr.com/editor/. The application interface will 
launch, displaying a start screen with options to create or open images (Figure 1-1).

Figure 1-1. The Pixlr Editor start screen

We’ll take a closer look at the start screen a little later in this chapter, but for now 
(if you’re following along on your computer) close it out by clicking the white X in the 
upper-right corner of the butterfly graphic. This will allow an unobstructed view of the 
workspace.

https://pixlr.com/editor/
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The Pixlr Editor Workspace
Now, let’s become better acquainted with the Pixlr Editor workspace—we’ll just take 
a quick tour in this section for now, but topics such as tools, the menu bar, etc., will be 
explored in greater depth in later chapters. Figure 1-2 shows the Pixlr Editor workspace 
and identifies the main parts.

Figure 1-2. The Pixlr Editor workspace

Here’s a quick breakdown of the Pixlr Editor workspace:

 1. The Toolbar—This palette contains the digital tools you’ll 
work with. There are tools for making selections, applying 
colors, erasing portions of an image, etc. Because there are so 
many, each tool will be examined more closely in Chapter 2.

 2. Additional Options—Most tools can be configured as needed. 
For example, you can adjust the diameter, shape, opacity, and 
flow of the brush tools. Not all tools have additional options.

 3. The Menu Bar—The menu bar contains a sundry of functions 
for image editing. You’ll find commands for opening and saving 
images, adjusting images, applying filters for effects, and much 
more. There are many functions contained in the menu bar, all 
of which will be examined more closely in Chapter 3.

http://dx.doi.org/10.1007/978-1-4842-2698-8_2
http://dx.doi.org/10.1007/978-1-4842-2698-8_3
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 4. User Login/Logout and User Settings—After creating a Pixlr 
account, this area is where you can log in or out, as well as 
update your account information.

 ■ Note Creating a Pixlr account is free, and you are not required to submit any sensitive 
personal information. Pixlr Editor can be used without an account, but you won’t be able 
to save images to the Pixlr library, only to your computer (or an external storage such as a 
flash drive).

 5. The Navigator Palette—This feature helps you find your way 
around the image at close magnification (Figure 1-3).

Figure 1-3. The Navigator Palette

 6. The Layers Palette—This is one of the areas where you’ll 
work with layers (you can also access them from the menu 
bar to some extent). The Layers Palette displays a thumbnail 
image of each layer (Figure 1-4). Each layer can be named, be 
re-ordered in the stack, the opacity lowered, deleted, etc.
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 ■ Note If you’re a complete beginner to image editing, layers can be thought of as clear 
sheets that contain a graphical element. when stacked one on top of another, they combine 
to form a complete image. to learn more, refer to the The Beginner’s Guide to Layers Pdf, 
which can be obtained from the Source Code/downloads tab of this apress page:  
http://www.apress.com/9781484226971.

 7. The History Palette—When working with Pixlr Editor, a 
snapshot of each editing step is stored in the History Palette, 
showing up to 16 actions (Figure 1-5). This allows you revert 
to an earlier point in the editing process should you find it 
necessary to revise any previous editing steps or eliminate 
mistakes.

Figure 1-4. The Layers Palette helps manage layers

http://www.apress.com/9781484226971
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 8. The Image Window/Canvas—This is where the image 
you are working on appears. The image may be a digital 
photograph or a blank canvas for a graphic design you intend 
to create.

 9. Status Bar—This shows the dimensions of the image in pixels, 
as well as the zoom percentage.

 10. Advertisements—Because Pixlr Editor is free, it’s supported 
by advertisements. The ad is small, but can be closed if 
desired.

Pixel-Based Images Explained
Pixel-based images (also known as raster images) are comprised of many tiny squares 
called pixels. A pixel (derived from the term picture element) is an individual unit of color 
and tonal value as represented on a computer display. The color and value of each pixel 
can vary—when viewed at close magnification, the block-like appearance is obvious 
(Figure 1-6), but when viewed from a distance the colors and tones appear to gradually 
and smoothly transition in the image.

Figure 1-5. The History Palette allows the user to revert to an earlier point in the editing 
process
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As the name suggests, Pixlr Editor is a pixel-based image editing application.  
This means that images are resolution-dependent. When a digital photo is resized 
too much, the image quality diminishes. Pixlr Editor is designed to output images for 
digital/web-based displays, not high-end print such as that one would acquire from a 
service bureau. However, it is possible to output files as standard-sized photographic 
prints, provided you start with a high resolution image to edit. This will be explained in 
greater detail in Chapter 4.

You may have heard the term vector graphics, but aren’t sure what it means. Even 
though they aren’t relevant to Pixlr Editor, vector graphics warrant some explanation. 
Vector graphics are different than raster graphics in the sense that they are created using 
mathematical formulas to form geometric shapes. Unlike raster graphics, vector graphics 
are scalable, meaning they can be enlarged or reduced in size with no image degradation.

However, photographs don’t generally display well as vector-based images. Whereas 
pixel-based images such as digital photos show a transition of color and tone, vector 
graphics are usually composed of areas of solid color (Figure 1-7).

Figure 1-6. Pixels appear as blocks under close magnification

http://dx.doi.org/10.1007/978-1-4842-2698-8_4
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In addition to being an advanced photo editing application, Pixlr Editor can also 
serve as graphics creation tool. However, unlike those created using a vector-based 
program, graphics created using this program are pixel-based. The illustration of the city 
scape was created using Pixlr Editor (Figure 1-8).

Figure 1-8. A pixel-based (raster) illustration created using Pixlr Editor (Copyright 2016 
Phillip Whitt)

Figure 1-7. A pixel-based (raster) image and a vector-based image
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Image File Formats
Image file formats are standards for storing digital data as a computer file. Each different 
file format is best suited for a specific purpose. Pixlr Editor handles a number of image 
file formats.

Here is a look at the formats Pixlr Editor can work with:

•	 PXD (Pixlr Document)—This is the proprietary file format used 
by Pixlr Editor and should be used to preserve layers for future 
editing or revisions of your project. It’s good practice to always 
keep your work saved as a PXD file, then output a copy of the 
finished of the work in another file format. Pixlr Editor can both 
open and save files in the PXD format.

•	 JPEG (Joint Photographic Experts Group)—The JPEG file format 
is one of the most common file formats in use for digital images. 
The JPEG format is versatile because it can compress image data 
for a manageable file size while maintaining good image quality. 
The JPEG format is known as a lossy format. Compressing an 
image discards image data—if an image is compressed too much, 
the quality will suffer. Image files saved in the JPEG format are 
normally used for display on the web. They can also be used for 
print, as long the resolution is sufficient. Pixlr Editor can open and 
save JPEG images.

•	 GIF (Graphics Interchange Format)—GIF is another format 
commonly used on the web. Unlike JPEG files, GIF files can 
support transparent backgrounds. This file format is often used 
for simple web animations. Pixlr Editor can open GIF files as 
flattened, static images, but cannot save images as GIF files.

•	 PNG (Portable Network Graphics)—The PNG image file is a 
lossless format. This format provides image data compression 
with little loss of image quality. PNG files are also typically used 
on the web. Unlike JPEG files, PNG files support transparent 
backgrounds. Pixlr Editor can open PNG images and save images 
as PNG files.

•	 BMP (Bitmap Image File)—The BMP is a raster graphics file 
format that is non-destructive. Images are saved in high quality, 
but result in large file sizes. Generally, BMP files are better suited 
for print and not web use. Pixlr Editor can save files in the BMP 
format, and can open most. However, extremely large BMP files 
would likely be an exception.

•	 TIFF (Tagged Image File Format)—This is a versatile, widely 
used format used in the graphics industry. Like BMP, this is a 
good choice when image quality is important and destined for 
print rather than web use. Pixlr Editor can save files in the TIFF 
format as flattened images, but can’t open TIFF files.
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•	 PSD (Photoshop Document)—This is the default file format 
used by Adobe Photoshop. PSD files often contain layers utilizing 
features unique to Photoshop that aren’t supported in Pixlr Editor. 
Therefore, the application’s ability to handle some PSD files is 
limited. Pixlr Editor can open (with limits) PSD files, but can’t 
save image files in the PSD format.

Opening Images
Upon opening Pixlr Editor, the start screen will appear (as you saw earlier in this chapter). 
There following options are presented in Figure 1-9.

•	 Create New Image

•	 Open Image From Computer

•	 Open Image From URL

•	 Open Image From Library

Figure 1-9. The options presented on the start screen

 ■ Note these options can also be accessed from Pixlr Editor’s menu bar under file. 
we’ll look closer at the Create new Image option in Chapter 10.

http://dx.doi.org/10.1007/978-1-4842-2698-8_10
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To open an image from your computer, simply click that option and navigate to the 
folder containing that image. The example in Figure 1-10 shows that the image I want to 
open is in a folder titled Photos to Edit, which is on the computer’s desktop.

Figure 1-10. Opening an image contained in a folder on the computer desktop

To open an image an image from a URL, follow these steps:

 1. Click Open Image From URL in the Pixlr Editor start screen.

 2. Open a new tab, then navigate to the web page hosting the 
image you want.

 3. Right-click on the image and click Copy Image Address 
(Figure 1-11).
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Figure 1-12. Paste the image address in the dialog box to open in Pixlr Editor

Figure 1-11. Copy the image address of the image you want to open

 ■ Note the example shown here is using Google Chrome—the wording in the command 
may vary depending on the browser being used.

 4. Click the tab running Pixlr Editor and paste the address in the 
dialog box (Figure 1-12). Then click OK.

The image should now be opened in Pixlr Editor, ready to edit, as shown in Figure 1-13.
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 ■ Note It’s important to remember that images hosted on the web (unless they’re in 
the public domain) are protected by copyright laws. It’s always advisable to obtain written 
permission from the copyright owner before using an image hosted on the Internet for 
publication.

Saving Images
Pixlr Editor offers two places to save your images—your computer or the Pixlr Library 
(Figure 1-14).

Figure 1-13. The image now opened in Pixlr Editor



ChaPtEr 1 ■ an OvErvIEw Of PIxlr EdItOr

16

A Pixlr account isn’t required to use the application and to save images to your 
computer. Of course, the advantage to having an account is access to the library, thus 
saving space on your computer. The library can serve as a backup of your work if you save 
your images to both places after each editing session.

If you prefer not to set up a Pixlr account, you should always back your work up 
somewhere—on a flash drive, external hard drive, or cloud service.

Your images can be saved in the following file formats using Pixlr Editor (Figure 1-15):

•	 JPEG

•	 PNG

•	 BMP

•	 TIFF

•	 PXD (Pixlr Editor’s native format for using with layered images)

Figure 1-14. Pixlr Editor can save images to your computer or the Pixlr Library

www.allitebooks.com

http://www.allitebooks.org
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Figure 1-15. File format options for saving images

Summary
If you’re a beginner at image editing software, hopefully you now have some rudimentary 
understanding of this program. If you feel lost or overwhelmed, don’t worry—things will 
make more sense the further into this book you go.

This chapter provided an overview of Pixlr Editor—we looked at launching the 
application, using the workspace, pixel-based images, image file formats, and opening/
saving images.

The next chapter includes an in-depth look at the tools used in Pixlr Editor.



19© Phillip Whitt 2017
P. Whitt, Beginning Pixlr Editor, DOI 10.1007/978-1-4842-2698-8_2

CHAPTER 2

Pixlr Editor Tools

This chapter looks at the broad set of tools at your disposal in Pixlr Editor. Here’s what 
you’ll learn:

•	 The Tool’s Purpose and Function: Each tool’s purpose and how it 
functions is described—an oversized icon representing the tool 
is shown in each figure to help the reader recognize it by sight on 
the toolbar.

•	 Tool Shortcuts: Tool keyboard shortcuts use a single alphabetic 
character and are indicated after the tool’s name in parentheses. 
Once you memorize them, these keyboard shortcuts can 
dramatically reduce the time spent during an editing session.  
Tool shortcuts are included in the descriptions where applicable 
(not all tools have keyboard shortcuts).

•	 Tool Options: Many tools have options available in addition 
to their default settings. These options are described when 
applicable (not all tools have them).

 ■ Note  If you’re a complete beginner and would like to try out each tool, there are 
practice images provided (with instructions on PDF) located in the Tools Tryout Guide and 
Practice Images folder, which can be obtained from the Source Code/Downloads tab from 
this Apress page: http://www.apress.com/9781484226971.

The Tools and How They Work
The purpose of this chapter is to introduce you to the tools and describe how they work.

You’ll be using many of these tools as you work through the tutorials in the second 
part of this book, Part II, “Working with Images.”

We will now take a look at each tool—its name, shortcut, description of its purpose, 
and additional options.

http://www.apress.com/9781484226971
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Crop Tool (Shortcut: C)
The Crop tool is used for trimming by removing excess image data for image composure 
(Figure 2-1).

Figure 2-1. The Crop tool trims away excess image data

Figure 2-2. The Crop tool Confirm dialog box

You use this tool by clicking and dragging around the area to be trimmed and then 
clicking the Crop tool icon. You’ll be presented with a Confirm dialog box, prompting you 
to apply the changes (Figure 2-2).

Alternatively, you can double-click in the image or press Enter to make the change 
without the prompting the Confirm dialog box.
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Additional Options
The Crop tool has three Constraint settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 No Restriction—The width and height of the crop can be adjusted 
independently.

•	 Aspect Ratio—Allows the tool to be set as either a perfect square 
or rectangle whose width remains proportional to the height as 
the tool is dragged.

•	 Output Size— The overall width and height remain the same after 
the image is cropped.

Move Tool (Shortcut: V)
The Move tool is used to reposition graphical elements. By clicking on the element and 
holding the mouse button down, you can move the element anywhere in the image 
(Figure 2-3).

Figure 2-3. The Move tool is used to reposition graphical elements

Additional Options
None
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Figure 2-4. Selecting the domino graphic using the Marquee tool

Marquee Tool (M)
The Marquee tool is used to make four types of selections—rectangular, square, elliptical, 
and circular. In Figure 2-4, the Marquee tool is being used to make a rectangular selection 
around the graphic of a domino. The boundary is defined by dashed lines that appear 
to move around the selected area like “marching ants” (a term commonly used in the 
graphic design world).

To add to a selection, hold the Shift key down. To subtract from a selection, hold the 
Control key down.
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•	 Anti-Alias—This option helps create smoother lines and curves in 
selections by reducing the appearance of jagged edges.

Additional Options
The Marquee tool has several settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 Rectangle/Circle or Elliptical/Circle—Indicated by icons.

•	 Constraint:

•	 No Restriction—The width and height of the selection can be 
adjusted independently (either by clicking and dragging, or 
using the Width/Height numeric input boxes).

•	 Aspect Ratio—Allows the tool to be set as either a perfect 
square (which it does by default) or rectangle whose width 
remains proportional to the height as the tool is dragged. The 
settings can be changed using the Width/Height numeric 
input boxes.

•	 Output Size—Crops the image but maintains the current 
width and height.

•	 Feather—This option softens the edge of the selection (Figure 2-5). 
The higher the numeric value entered in the numeric input box, 
the softer the edge.

Figure 2-5. Using the Feather tool option softens the edge
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Lasso Tool (L)
The Lasso tool is used for making selections around objects with irregular shapes or 
polygonal shapes, as shown in Figure 2-6.

Figure 2-6. Using the Lasso tool to make a selection

To add to a selection, hold the Shift key down. To subtract from a selection, hold the 
Control key down.

Additional Options
The Lasso tool has several settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Free Hand or Polygonal Selection—Indicated by icons.

•	 Feather—Creates a soft edge around the selection.

•	 Anti-Alias—Creates smoother lines by reducing jagged edges.
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Wand Tool (W)
The Wand tool is used for making selections based on color and tone. For example, the 
red areas of the beach ball are quickly selected by clicking them with the Wand tool 
(Figure 2-7).

Figure 2-7. The Wand tool selects areas by color and tone

To add to a selection, hold the Shift key down. To subtract from a selection, hold the 
Control key down.

Additional Options
The Wand tool has several settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Tolerance—Adjusts the range of color and tone the Wand tool 
selects. The higher the number, the wider the range the tool 
selects.

•	 Anti-Alias—Creates smoother lines by reducing jagged edges.

•	 Contiguous—Selects continuous areas of color and tone.
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Pencil Tool (No Shortcut)
The Pencil tool is used for drawing as you would with an actual pencil, and it mimics a 
pencil’s characteristics quite well (Figure 2-8).

Figure 2-8. The Pencil tool can be used for digital sketching and drawing

Additional Options
The Pencil tool has several settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Type—Allows you to draw the following types of lines (Figure 2-9):

•	 Plain—A basic, hard pencil line.

•	 Sketchy—Resembles lines rapidly sketched out.

•	 Trail—Draws lines that trail off slightly at the ends.

•	 Shaded—Draws angled and curved lines with a smudged 
effect.

•	 Sticky—Draws lines drawn with a sticky or waxy medium 
effect.

•	 Ink—Resembles lines drawn with an artist’s marker.
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•	 Size—The line diameter measured in pixels.

•	 Opacity—Controls how opaque or transparent a line is.

•	 Amount—Controls how much of an effect is applied.

Brush Tool (B)
The Brush tool is used for applying color in the fashion an artist’s paintbrush does. It can 
be used for creating digital paintings and illustrations (Figure 2-10).

Figure 2-9. The Pencil tool can create various types of lines
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Additional Options
The Brush tool has numerous settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 Brush—Offers a plethora of preset choices, including nibs of 
assorted shapes and sizes, hard or soft tips, and other settings 
(Figure 2-11).

Figure 2-10. The Brush tool can be used to create digital paintings

Figure 2-11. The Brush tool settings come in a wide assortment shapes and sizes
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Under the More subset, there are specialty brushes such as Artistic, Nature, Makeup, 
Shapes, and Misc (Figure 2-12).

Figure 2-13. The Eraser tool removes image data

Figure 2-12. Additional brush options under the More subset

•	 Opacity—Controls how opaque or transparent the applied color is.

•	 Hard Tip—Gives the brush currently being used a hard-tipped nib.

•	 Scatter—Creates multiple copies of the brush tip with each stroke.

•	 Diffuse—Creates a misty, splattered effect similar to using spray paint.

Eraser Tool (E)
The Eraser tool removes image data (Figure 2-13). On non-layered images, it removes 
data, revealing the underlying background color.
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On layered images, using the Eraser tool reveals the image data on the underlying 
layer(s), as shown in Figure 2-14.

Figure 2-14. Using the Eraser tool on a layered image

Additional Options
The Eraser tool has the following settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Opacity—Controls how opaque or transparent the erased data is.

Paint Bucket Tool (G)
The Paint Bucket tool is used for quickly applying color to large areas of an image 
(Figure 2-15).
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Additional Options
The Paint Bucket tool has several settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 Opacity—Controls how opaque or transparent the filled area is.

•	 Tolerance—Controls how little or how much color fills an area. 
Lower tolerance settings restrict the function to pixels that are 
closest in color or tone. Higher tolerance settings extend to pixels 
less similar in color or tone (Figure 2-16).

Figure 2-15. The circular selection filled in using the Bucket Fill tool

Figure 2-16. Comparison of lower and higher tolerance settings
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•	 Anti-Alias—Creates smoother lines by reducing jagged edges.

•	 Contiguous—Selects continuous areas of color and tone.

•	 All Layers—Allows you to apply the fill to an area on a layer 
separate from that containing the colors being sampled.

Gradient Tool (No Shortcut)
The Gradient tool is used for creating a transition of one color to another. As shown in 
Figure 2-17, the circular selection is filled with the default setting gradient that starts as 
white and ends in black.

Figure 2-17. Example of a gradient

Additional Options
The Gradient tool has several settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 Opacity—Controls how opaque or transparent the filled area is.

•	 Gradient—Offers 43 preset gradients of varying styles and colors.

•	 Linear/Radial (Figure 2-18)—Lets you choose between creating a 
gradient that extends from one point to another in a straight line 
(linear), or a gradient that starts at one point and extends outward 
in every direction (radial).
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•	 Spread Method—Controls the way the gradient flows.

•	 Pad (default)

•	 Reflect (creates a mirrored effect)

•	 Repeat (creates a pattern by repeating the gradient)

•	 Mode—Offers a choice blend modes, which create a variety of 
color effects.

Clone Stamp Tool (S)
The Clone Stamp tool is used for sampling pixels from one area and pasting them to 
another. In Figure 2-19, the star on the far left is sampled and then copies of it are pasted.

Figure 2-18. Comparison of a linear and radial gradient
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 ■ Note  the Clone Stamp tool is a staple for use in retouching and restoring images, 
because of its ability to sample good areas of the image and to paste them over flawed areas.

Additional Options
The Clone Stamp tool has several settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Opacity—Controls how opaque or transparent the filled area is.

•	 Aligned—When this option is checked, the sample point remains 
in close proximity to the Clone Stamp tool as you work along the 
image.

•	 Sample All Layers—Allows you to sample image data from an 
image and paste it on to a different layer.

Figure 2-19. Using the Clone Stamp tool to make copies of the star
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Figure 2-20. Using the Color Replace tool

Color Replace Tool (No Shortcut)
The Color Replace tool is used to quickly change an area of the image from one color 
to another (Figure 2-20). This tool only works on RGB images with color, not grayscale 
images.

Additional Options
The Color Replace tool has several settings, which can be found in the Additional Options 
dialog box (located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Tolerance—Adjusts the range of color and tone the tool replaces. 
The higher the number, the wider the range of color the tool 
replaces.
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Figure 2-21. The Match Target Lightness option matches the lightness value of the selected 
target color

Draw Tool (No Shortcut)
The Draw tool is used for creating basic shapes (Figure 2-22). The Draw tool can be used 
to create simple illustrations.

•	 Match Target Lightness—Matches the lightness value of the 
selected target color (Figure 2-21). When unchecked, the lightness 
value of the underlying color is matched.
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Additional Options
The Draw tool has several settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Shapes—Includes rectangle, rounded rectangle, ellipse, and line.

•	 Opacity—Controls how opaque or transparent the filled area is.

•	 Mode—Offers a choice blend modes, which create a variety of 
color effects.

•	 Border Size—Controls the size of the border around the shape 
(setting the option to zero adds no border).

•	 Fill Shape—Fills the shape with color when the option is checked 
(click the small rectangle to the right to access the Color Selector).

Figure 2-22. An illustration created using the Draw tool

www.allitebooks.com

http://www.allitebooks.org
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This tool can be used to reduce the harshness of hard edges, eliminate small specks 
of dust on old photos, and for portrait touch-up work (to soften skin and blemishes).

Additional Options
The Blur tool has two settings, which can be found in the Additional Options dialog box 
(located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Strength—Controls how strong the blurring effect is.

Sharpen Tool (Y)
The Sharpen tool is used to increase the apparent sharpness of image data in local areas 
(Figure 2-24). This tool can be used to make local areas of an image appear to be a bit 
more in focus.

Figure 2-23. Using the Blur tool to soften image data

Blur Tool (R)
The Blur tool is used to soften image data in local areas (Figure 2-23).
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Figure 2-24. Using the Sharpen tool to increase image data sharpness

Additional Options
The Sharpen tool has two settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Strength—Controls how strong the sharpening effect is.

Smudge Tool (U)
The Smudge tool is used to create a smeared effect (Figure 2-25). The effect is similar to 
that of running a finger through wet paint. This tool can be used to create a motion effect 
and is also used in portrait touch-up.
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Additional Options
The Smudge tool has two settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Strength—Controls how strong the smudge effect is.

Sponge Tool (P)
The Sponge tool is used to increase or decrease color saturation in local areas. The left 
side shows color desaturation (reduced color intensity), while the right shows increased 
color saturation (intensity) (Figure 2-26). This tool can be useful when retouching old 
color photographs with uneven color fading.

Figure 2-25. Using the Smudge tool to create a smeared effect
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Figure 2-26. The Sponge tool increases or decreases color saturation in local (specific) 
areas of the image

Additional Options
The Sponge tool has three settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Saturate/Desaturate—Increases or decreases color intensity.

•	 Strength—Controls how strong the effect is.

Dodge Tool (O)
The Dodge tool is used to lighten local areas in an image. This tool can be useful in 
correcting under exposure in specific areas of an image and to reveal detail lost in dark 
shadows (Figure 2-27).



ChAPter 2 ■ PIxlr eDItor toolS

42

Additional Options
The Dodge tool has three settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Shadows/Midtones/Highlights—Selects which tonal values to 
apply the Dodge tool. To lighten a dark area in an image, the 
Shadows option is selected, for the middle range the Mid-tones is 
selected, and for the lightest areas the Highlights is selected.

•	 Exposure—Controls how strong the lightening effect is.

Burn Tool (N)
The Burn tool is used to darken local areas (Figure 2-28). This tool can be useful for 
making corrections in local areas of images that are overexposed.

Figure 2-27. The Dodge tool lightens local areas in an image
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Figure 2-28. The Burn tool darkens local areas in an image

Additional Options
The Burn tool has three settings, which can be found in the Additional Options dialog box 
(located under the menu bar):

•	 Brush—Opens the Brush Preset dialog box.

•	 Shadows/Midtones/Highlights—Like the Dodge tool, this option 
selects which tonal values to apply to the Burn tool.

•	 Exposure—Controls how strong the darkening effect is.

Red Eye Reduction Tool (No Shortcut)
The Red Eye Reduction tool is used to correct the red eye effect that’s caused by light from 
the camera’s flash reflecting off the retina of the eyes (Figure 2-29).
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Additional Options
The Red Eye Reduction tool has one setting, which can be found in the Additional 
Options dialog box (located under the menu bar):

•	 Tolerance—Controls the range of pixels the effect is applied to 
(this option has a range from 0-100, and is set to 50 by default).

Spot Heal (No Shortcut)
The Spot Heal tool is used primarily to remove facial blemishes (Figure 2-30). It’s similar 
to the Clone Stamp tool, but instead of copying image data exactly, it calculates the 
surrounding tone, color, and texture to blend the effect in seamlessly. This is a valuable 
tool for portrait retouching.

Figure 2-29. The Red Eye Reduction tool corrects red eye caused by the camera's flash
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Additional Options
The Spot Heal tool has two settings, which can be found in the Additional Options dialog 
box (located under the menu bar):

•	 Size—Controls the brush diameter, which ranges from  
10-200 pixels.

•	 Type—Determines the tool effects (Blend Nearby samples the 
surrounding color, texture, and tone; Generate Pattern creates a 
pattern of digital noise).

Bloat Tool (A)
The Bloat tool is used to enlarge areas of an image (Figure 2-31).

Figure 2-30. The Spot Heal tool removes blemishes
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Additional Options
The Bloat tool has two settings, which can be found in the Additional Options dialog box 
(located under the menu bar):

•	 Size—Controls the brush diameter, which ranges from 4-400 
pixels.

•	 Strength—Controls how strong the effect is.

Pinch Tool (K)
The Pinch tool is used to distort areas of the image, producing the effect of converging 
image data to a central point (Figure 2-32).

Figure 2-31. The Bloat tool is used to enlarge portions of an image
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Figure 2-32. The Pinch tool producing an effect of converging image data to a central 
point

Additional Options
The Pinch tool has two settings, which can be found in the Additional Options dialog box 
(located under the menu bar):

•	 Size—Controls the brush diameter, which ranges from 4-400 
pixels.

•	 Strength—Controls how strong the effect is.

Colorpicker Tool (I)
The Colorpicker tool is used to sample color from an area (or areas) of the image 
(Figure 2-33). The color information is stored in the Set Main Color tool (we’ll look closer 
at that a little later).
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Additional Options
None

Type Tool (T)
The Type tool is used to add text to an image (Figure 2-34). The text is placed on its own 
layer, rather than directly on the image.

Figure 2-33. The Colorpicker tool is used to sample color
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Figure 2-34. The Type tool is used to place text over an image

Additional Options
Clicking on the Type tool icon prompts a dialog box, which offers the following options:

•	 Font—The typeface style you want for the text.

•	 Size—Controls the size of the text measured in pixels. The sizes 
range from 5-130.

•	 Style—Offers text choices of Regular, Bold, Italic, and Bold/Italic.

•	 Color—Prompts the Color Selector to give your text the color of 
your choice.

•	 Aligned—Provides left, center, or right alignment for the text.

Hand Tool (H)
The Hand tool is used to move the image when it’s at high magnification (Figure 2-35). 
When the tool is active, it’s used by clicking and dragging the image to the area you want 
to view.
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Additional Options
None

Zoom Tool (Z)
The Zoom tool is used to magnify the image when close examination is necessary 
(Figure 2-36). This tool can be used by clicking in the image to zoom in, or clicking and 
dragging around a specific area, then releasing the mouse button. To zoom out, hold the 
Shift key and click. The Zoom tool’s maximum magnification is 800%.

Figure 2-35. The Pan tool is used to move the image while at high magnification
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Figure 2-36. The Zoom tool is used to magnify the image

Additional Options
None

Set Main Color (No Shortcut)
This feature is used to set the main color (represented by the large swatch) to your 
choosing. The smaller swatches can contain custom colors. Clicking the swatch prompts 
the Color Selector dialog box, allowing you to move the circles and/or the sliders to 
achieve the color you want (Figure 2-37).
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By default, the Color Selector dialog box is set to the HSL (hue, saturation, and 
lightness) model. The outer ring represents all of the hue values, and the diamond shaped 
box represents the lightness value of the hue.

The other modes are:

•	 RGB—Based on red, green, and blue light generated by the 
computer’s monitor. Various amounts of each light achieve 
certain colors. 100% of red, green, and blue light results in white, 
0% of each results in black.

•	 Web—Used to select web-friendly colors.

•	 IMG—Essentially a palette of hexadecimal color swatches.

Summary
In this chapter, you were introduced to the tools that are used in editing images. To 
become better acquainted with these tools (primarily for those new to image editing), 
you should try each tool out on the practice image and instructions supplied in the Tools 
Tryout Guide and Practice Images folder, which can be obtained from the Source Code/
Downloads tab from this Apress page: http://www.apress.com/9781484226971.

The next chapter covers the functions in the Pixlr Editor menu bar.

Figure 2-37. The Color Selector dialog box

http://www.apress.com/9781484226971
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CHAPTER 3

The Pixlr Editor Menu Bar

This chapter looks at the functions that are accessed from the menu bar, as well as their 
keyboard shortcuts (when applicable). Here are the topics that will be covered:

•	 File: This section covers matters related to opening, saving, and 
printing your work.

•	 Edit: This section looks at the image editing functions available.

•	 Image: Here we look at functions related to the image such as 
image size, canvas size, rotating, flipping, and cropping.

•	 Layer: This section of the chapter looks at functions related to 
working with layers.

•	 Adjustment: This section looks at functions that adjust, correct, or 
modify the images tonality or color.

•	 Filter: Here we look at the filters and how they modify the image 
with specialized effects.

•	 View: This sections looks at various options available for viewing 
your image.

•	 Language: Lists all of the languages Pixlr Editor accommodates.

•	 Help: Lists various resources available if you need assistance.

•	 Login/Signup: Looks at how to sign up and log in to Pixlr Editor.

The File Menu
The File option is located on the far left side of the menu bar (Figure 3-1).
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The following options are available from the File menu:

 1. New Image (Control+N)―This dialog box creates a new, 
blank canvas for you to work in (Figure 3-2).

Figure 3-1. The File option

Figure 3-2. The New Image dialog box
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The options provided by the New Image dialog box are:

•	 A textbox to name the image.

•	 A choice of preset sizes (it’s set to 800 X 600 by default).

•	 Width and Height numeric input boxes. The size can also 
be adjusted by clicking the inverted triangles and using the 
sliders.

•	 Transparent (the background color is white by default).

 2. Open Image (Control+O)―This option allows you to open 
an existing image from your computer (if you recall, this was 
covered briefly in Chapter 1).

 3. Open Image URL (no shortcut)―This option allows you to 
open an image hosted on a web page into Pixlr Editor.

 4. Open Image Library (no shortcut)―This option requires 
opening a Pixlr account to use. The Pixlr library (a cloud 
service) is a convenient way to store your images.

 5. Save (Control+S)―Provides a choice of saving your work to 
your computer or to the Pixlr library. Your work can be saved 
in the following file formats:

•	 JPEG (Good for most photos)

•	 PNG (Transparent, full quality)

•	 BMP (Large but non-destructive)

•	 TIFF (Special format)

•	 PXD (Layered Pixlr image)

 6. Print (shortcut not indicated)―Launches the Printer Settings 
dialog box of the default printer.

 ■ Note even though there is no print shortcut indicated in pixlr editor’s print option, 
Control+p should work, depending on the browser being used.

 7. Close (Control+W)―Closes the active image. If edits are made 
to the image without saving the changes, a Confirm dialog box 
appears (Figure 3-3). At this point, you can save the changes, 
close the image without saving, or cancel the dialog box and 
continue editing.

http://dx.doi.org/10.1007/978-1-4842-2698-8_1
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 8. Login (no shortcut)―If you have a Pixlr account and are 
signed in, this logs you out.

 9. Signup (no shortcut)―Lets you sign up for a Pixlr account.

 10. Exit (Control+Q)―Leaves the Pixlr Editor site. A dialog box is 
prompted with a reminder stating that changes made in the 
image may not be saved if you leave the site (Figure 3-4). The 
dialog box appearance and wording may vary, depending on 
the browser you’re using.

 ■ Note  the functions listed under File may vary slightly from one browser to another.

The Edit Menu
Edit is the next option on the menu bar (Figure 3-5). The Edit option contains numerous 
functions for making changes to the image.

Figure 3-4. Clicking Exit prompts a dialog box confirming the action

Figure 3-3. The Confirm dialog box for the Close option
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The following options available from the Edit menu:

 1. Undo (Control+Z)―This operation undoes the last edit or 
function.

 2. Redo (Control+Y)―This operation reinstates the previously 
reverted edit or function.

 3. Cut (Control+X)―This operation deletes pixels from a 
selected area (Figure 3-6). The data is stored temporarily in an 
area called a clipboard.

Figure 3-5. The Edit option

Figure 3-6. The cut option deletes pixels from a selected area
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 4. Copy (Control+C)―This operation duplicates image data 
from a selected image or selected area and stores it in the 
clipboard.

 5. Clear (DEL)―This works in the same way as the Cut 
option, except the image data is deleted without storing it in 
clipboard.

 6. Paste (Control+V)―This applies image data stored in the 
clipboard to the image, or on to a new layer.

 7. Free Transform (Control+T)―This allows you to rotate, 
reshape, and resize images or graphical elements on an 
active layer (Figure 3-7). Holding the Shift key while resizing 
maintains the aspect ratio.

 8. Free Distort (no shortcut)―This allows you to alter the 
image’s perspective (Figure 3-8). In some cases, it can be used 
to correct images with perspective problems.

Figure 3-7. Free transform is used to rotate, resize, or reshape images
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 9. Select All (Control+A)―This applies a selection around the 
entire image or active layer.

 10. Deselect All (Control+D)―Cancels any active selections.

 11. Invert Selection (no shortcut)―Changes the selection to 
apply to previously unselected image data and ignores the 
previously selected data (Figure 3-9).

 12. Select Pixels (no shortcut)―Selects only the pixels on an 
active layer.

Figure 3-8. Free distort is used to alter perspective

Figure 3-9. Invert selection switches the image data that is selected
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 ■ Note  after a new brush is defined from an image, it remains in the brush palette only as 
long as pixlr editor is open. however, the new brush can be preserved by saving the brush set 
to your computer. the saved brush set can be loaded as needed for future editing sessions.

The Image Menu
The Image menu provides several functions for changing the size of the image, the 
canvas, and its position (Figure 3-11).

Figure 3-10. Define brush creates a brush from an image

Figure 3-11. The Image option

 13. Define Brush (Control+K)―Creates a brush from a selected 
image (Figure 3-10).
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The following functions are available from the Image menu:

 1. Image Size―This operation controls the overall dimensions 
of your image. The image dimensions are measured in 
pixels, as shown in Figure 3-12. New values can be entered 
in the Width and Height boxes to change the image size. By 
leaving the Constrain Proportions box checked, the original 
proportions of the image are maintained. Unchecking it will 
result in an image with distorted proportions.

The image size can also be changed by using the slider(s) in 
the Image Size dialog box (Figure 3-13).

 2. Canvas Size―This option controls the overall dimensions 
of the canvas (the background that the image rests on). For 
example, when the canvas width and height is increased by 
100 pixels, it leaves a border around the image (Figure 3-14).

Figure 3-12. New numeric values can be entered to change the image size

Figure 3-13. The image size can also be changed by using the slider(s)



Chapter 3 ■ the pixlr editor Menu Bar

62

The Canvas Size dialog box is similar to the Image Size dialog box in respect to 
the Width and Height numeric input boxes and sliders, but it doesn’t have a Constrain 
Proportions feature. It allows the image to be anchored in the center, lower-left, left, 
upper-left, top, upper-right, right, lower-right, and bottom in relation to the canvas 
(Figure 3-15).

 3. Rotate Canvas 180°―Rotates the canvas (including all layers) 
180 degrees, making the image appear upside down  
(Figure 3-16).

Figure 3-14. By increasing the canvas width and height by 100 pixels, a border is added to 
the image

Figure 3-15. The image can be anchored to various positions in relation to the canvas
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 4. Rotate Canvas 90° CW―Rotates the canvas (including all 
layers) 90 degrees clockwise (Figure 3-17).

 5. Rotate Canvas 90° CCW―Rotates the canvas (including all 
layers) 90 degrees counter-clockwise.

Figure 3-16. The image rotated 180 degrees

Figure 3-17. The image rotated 90 degrees clockwise
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 6. Flip Canvas Vertical―Flips the canvas vertically and reverses 
it (including all layers), as shown in Figure 3-18.

 7. Flip Canvas Horizontal―Flips the canvas horizontally, 
resulting in a reversed image (including all layers), as shown 
in Figure 3-19.

 8. Crop―Trims an image to the dimensions of a selection 
(Figure 3-20).

Figure 3-18. The image flipped vertically and reversed

Figure 3-19. The image flipped horizontally
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The Layer Menu
The Layer menu provides a number of functions for working with layers (Figure 3-21).

 ■ Note  if you are a beginner to image editing, i suggest you look over the The Beginner’s 
Guide to Layers pdF, which can be obtained from the Source Code/downloads tab from this 
apress page: http://www.apress.com/9781484226971.

Figure 3-20. The image cropped to the dimensions of the selection

Figure 3-21. The Layer menu

http://www.apress.com/9781484226971
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The following functions are available from the Layer option:

 1. New Layer―Creates a new blank layer.

 2. Duplicate Layer―Creates a duplicate of the active layer.

 3. Delete Layer―Deletes any layer that’s no longer needed.

 4. Open Image as Layer―Opens another image as a layer 
and places it at the top of the layer stack of the image that’s 
currently open (Figure 3-22).

 5. Open Image URL as Layer―Opens an image hosted on a web 
page as a layer and places it at the top of the layer stack of the 
image that’s currently open.

 6. Open From Library as Layer―Opens an image from the 
library as a layer and places it at the top of the layer stack of 
the image that’s currently open.

 7. Merge Down―Combines the active layer with the one 
directly beneath into one layer (Figure 3-23).

Figure 3-22. The image of the white car opened as a layer placed in the image of the  
green car

Figure 3-23. Merge Down combines the active layer with the layer directly beneath it
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 8. Merge Visible―Combines the layers with the visibility box 
checked into one layer (Figure 3-24). The invisible layers 
remain unchanged.

 9. Flatten Image―Combines all of the image layers into one 
background layer with no transparency.

 10. Move Layer Up―Moves the active layer up one level in the 
stacking order.

 11. Move Layer Down―Moves the active layer down one level in 
the stacking order.

 12. Layer Styles―Special effects that are applied to individual 
layers (Figure 3-25). You can apply one or more of the 
following effects:

•	 Drop shadow

•	 Inner shadow

•	 Bevel

•	 Outer glow

•	 Inner glow

Figure 3-24. Merge Visible combines the visible layers into one
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 13. Rasterize Layer―Coverts a vector-based text layer into a 
raster layer (Figure 3-26).

 14. Add Layer Mask―Adds a mask that hides the pixels of the 
active layer. Painting in the layer mask allows the user to 
reveal only selected portions of the image (Figure 3-27). By 
adjusting the opacity of the brush, the pixels can range from 
semi-transparent to fully opaque.

Figure 3-26. A vector text layer converted into a raster layer

Figure 3-25. Layer styles are special effects applied to individual layers
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 15. Delete Layer Mask―Removes the layer mask, reverting the 
layer to its original state.

 16. Apply Layer Mask―Commits the changes made to the layer 
and removes the layer mask.

 17. Rotate Layer 180°―Rotates the active layer 180 degrees 
(other layers remain unchanged).

 18. Rotate Layer 90° CW―Rotates the active layer 90 degrees 
clockwise (the other layers remain unchanged).

 19. Rotate Layer 90° CCW―Rotates the active layer 90 degrees 
counter-clockwise (the other layers remain unchanged).

 20. Flip Layer Vertical―Flips the active layer vertically, reversing 
the layer’s contents (the other layers remain unchanged).

 21. Flip Layer Horizontal―Flips the active layer horizontally, 
reversing the layer’s contents (the other layers remain 
unchanged).

The Adjustment Menu
The Adjustment menu hosts a number of functions for making tonal and color 
adjustments in the image (Figure 3-28).

Figure 3-27. A layer mask allows you to reveal selected parts of the image
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Here’s a look at the functions that are available from the Adjustment option:

 1. Brightness & Contrast (no shortcut)―Opens a dialog box 
used for making adjustments in the brightness and/or 
contrast of an image (Figure 3-29). This is helpful for quickly 
boosting contrast in dull images.

Figure 3-28. The Adjustment menu

Figure 3-29. The Brightness & Contrast dialog box helps improve dull images

 2. Hue & Saturation (Control+U)―Opens a dialog box used 
for making adjustments in the overall hues (color values), 
saturation (color intensity), and lightness of the image 
(Figure 3-30). Checking the Colorize option applies a 
monochromatic color tint to the image.
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 3. Color Balance (no shortcut)―Opens a dialog box used for 
correcting color imbalances. In the example shown (Figure 3-31),  
the image has a heavy magenta color cast. By increasing the 
green offset, the color cast is reduced.

Figure 3-30. The Hue & Saturation dialog box adjusts the hue, saturation, and lightness

Figure 3-31. The Color Balance dialog box helps improve images with color casts

 4. Color Vibrance (no shortcut)―Similar to saturation, this is 
used to increase color intensity. It’s a good choice to use in 
images that contain skin tones because it maintains a natural 
look (Figure 3-32).
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 5. Levels (Control+L)―This dialog box is used for making tonal 
adjustments in the highlights, midtones, and shadow ranges. 
It’s an effective tool for improving contrast in dull images 
(Figure 3-33).

 6. Curves (Control+M)―like Levels, this dialog box is also used 
for making tonal adjustments (Figure 3-34). However, it’s a 
better choice when more precise control is required.

Figure 3-34. The Curves dialog box is used when greater precision is required

Figure 3-32. The Color Vibrance dialog box boosts color intensity while maintaining 
natural skin tones

Figure 3-33. The Levels dialog box is effective for making tonal corrections
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 ■ Note the levels and Curves dialog boxes are both powerful and somewhat complex. 
they are covered at in greater depth in Chapter 5.

 7. Exposure (no shortcut)―Makes quick corrections to images 
with exposure problems (Figure 3-35).

 8. Auto Levels (no shortcut)―Makes an automatic levels 
adjustment in one click (Figure 3-36).

 9. Invert (Control+I)―Switches the colors and tonal values 
in the image to their opposites as they would appear in a 
photographic negative (Figure 3-37).

Figure 3-35. The Exposure dialog box makes quick corrections to images with exposure 
problems

Figure 3-36. The Auto levels function works in one automatic operation

http://dx.doi.org/10.1007/978-1-4842-2698-8_5
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 10. Sepia (no shortcut)―Applies a sepia tone to the image 
(Figure 3-38).

 11. Solarize (no shortcut)―Mimics a photographic processing 
technique in which some of the image’s colors and tonal values 
are inverted and some remain unchanged (Figure 3-39).

Figure 3-38. The Sepia function simulates sepia toning

Figure 3-37. The Invert function reverses the colors and tonal values



Chapter 3 ■ the pixlr editor Menu Bar

75

 12. Desaturate (no shortcut)―Removes all of the colors from 
the image, leaving only the black, white, and gray values 
(Figure 3-40).

 13. Old Photo (no shortcut)―Gives the image an appearance of 
an aged photograph (Figure 3-41).

Figure 3-39. Solarize inverts some of the colors and tonal values

Figure 3-40. Desaturate removes the colors, leaving only black, white, and gray values
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 14. Cross Process (no shortcut)―Mimics the technique of 
purposely processing one film type using a photographic 
chemical intended for another film type. (Figure 3-42).

 15. Threshold (no shortcut)―Converts the image to pure black 
and white pixels (Figure 3-43). The slider in the dialog box 
adjusts the range of black/white pixels.

Figure 3-42. Cross processing is mimicked in this image

Figure 3-41. Old Photo gives the image an aged appearance
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 16. Posterize (no shortcut)―Eliminates the continuous gradation 
of tone for a stylized artistic effect (Figure 3-44). The strength 
of the effect is controlled by the slider in the dialog box.

 17. Color Lookup (no shortcut)―Maps the color and tonal values 
from a gradient to the image (Figure 3-45). The color stops in 
the Gradient dialog box can be adjusted by using the sliders.

Figure 3-43. Threshold converts the image to black and white pixels

Figure 3-44. Posterize creates a stylized effect



Chapter 3 ■ the pixlr editor Menu Bar

78

The Filter Menu
The Filter menu consists of 28 functions for applying specialized effects. Some filters have 
useful applications for image correction (such as Blur and Sharpen) that modify focus). 
Others apply artistic, photographic, and fun effects.

Here’s a look at the filters and the effects applied by each one:

 1. Blur―Softens the image focus very slightly. The filter can be 
applied repeatedly to increase the effect.

 2. Box Blur―Softens the image focus based on contrasting areas in 
an image. Some detail may be left in linear areas (Figure 3-46).

Figure 3-46. The Box Blur filter

Figure 3-45. Color lookup maps the color and tonal values from a gradient to the image
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 3. Gaussian Blur―Also used for blurring images (Figure 3-47), 
but softens the image more smoothly than Box Blur. Gaussian 
Blur simulates the effect of viewing the image through a 
translucent screen. The strength of the effect is controlled by 
the slider in the dialog box.

 4. Sharpen―Increases the contrast between neighboring pixels 
to make the image appear slightly sharper. The filter can be 
applied repeatedly to increase the effect.

 5. Unsharp Mask―Offers greater control than the Sharpen 
filter (Figure 3-48). The dialog box uses these three settings to 
achieve the best results possible:

•	 Amount: The percentage of the effect applied.

•	 Radius: The size of the edges to be sharpened.

•	 Threshold: Helps prevent excessive speckling in smooth 
areas.

Figure 3-47. The Gaussian Blur filter
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 6. Denoise―Helps remove excessive digital noise from the 
image.

 7. Noise―Introduces noise into the image (Figure 3-49). The 
amount is controlled by the slider in the dialog box, and there 
is a monochromatic option box.

Figure 3-48. The Unsharp Mask filter

Figure 3-49. The Noise filter
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 8. Diffuse―Creates a soft, impressionist-like image (Figure 3-50). 
The strength of the effect is controlled by the slider in the 
dialog box.

 9. Scanlines―Creates the effect of the image being displayed 
on a CRT display (Figure 3-51). The strength of the effect 
is controlled by the slider on the dialog box, and there is a 
Horizontal option available.

Figure 3-50. The Diffuse filter

Figure 3-51. The Scanlines filter
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 10. Halftone―Mimics the effect of a photographic image printed 
on an offset printer characterized by the dots (Figure 3-52). 
Various aspects of the filter are controlled in the dialog box.

 11. Pixelate―Applies an effect that enlarges the pixels of the 
image to obscure detail or create a digitized look (Figure 3-53).

Figure 3-52. The Halftone filter

Figure 3-53. The Pixelate filter
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 12. Pointinize―Divides the image into equally spaced dots, 
squares, large circles, or small circles using the dialog box 
(Figure 3-54).

 13. Water Swirl―Applies a distortion, making the image appear 
to be submerged in water (Figure 3-55). The Amount and Size 
options are controlled by sliders in the dialog box, and there is 
an option box for horizontal waves.

Figure 3-54. The Pointinize filter

Figure 3-55. The Water Swirl filter
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 14. Polar Coordinates―Twirls the image from its original state to 
polar coordinates. The example shown (Figure 3-56) has Rect 
(rectangle) set to polar. The other settings are Polar to rect and 
Invert in circle.

 15. Kaleidoscope―Creates a kaleidoscope-like pattern from the 
image (Figure 3-57). The Size, Horizontal, and Vertical settings 
are controlled using the sliders in the dialog box.

Figure 3-56. The Polar Coordinates filter

Figure 3-57. The Kaleidoscope filter
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 16. Tilt Shift―Simulates a photographic technique involving 
selective focus, making the scene appear as a miniature  
model set (Figure 3-58). The Focus, Size, and Location settings 
are controlled by sliders in the dialog box, and a Saturate  
(that boosts color intensity) checkbox is provided.

 17. Vignette―Simulates a photographic technique that obscures 
the sides and corners of the image. This technique is 
commonly used in portrait photography (Figure 3-59). The 
size of the vignette is controlled by the slider in the dialog box, 
and the color of the vignette can be changed using the Color 
Selector.

Figure 3-58. The Tilt Shift filter

Figure 3-59. The Vignette filter
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 18. Pastels―Applies an artistic effect to the image, simulating 
the look of having been drawn pastels (Figure 3-60). The size 
of the strokes is controlled by the slider in the dialog box, and 
the Invert option checkbox switches some of the lightest pixels 
to dark.

 19. Glamour Glow―Increases contrast and softens focus slightly 
to help add smoothness and radiance to the skin (Figure 3-61).

Figure 3-60. The Pastes filter applies an effect similar to pastels

Figure 3-61. The Glamour Glow filter
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 20. Mimic HDR―Simulates High Dynamic Range photography, 
which results in a higher range of dynamic luminosity 
throughout the image (Figure 3-62).

 21. Hope―Simulates the artistic style (Figure 3-63) used by 
artist Shepard Fairey to create the image of President Barrack 
Obama on the famous 2008 campaign poster titled Hope.

Figure 3-62. The Mimic HDR filter simulates high dynamic range photography

Figure 3-63. The Hope filter

www.allitebooks.com

http://www.allitebooks.org
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 22. Art Poster―Creates a stylized effect from the image using 
large areas of solid color (Figure 3-64). The amount of the 
effect applied and the color is controlled by the sliders in the 
dialog box. An Invert option (reverses colors and tones) is 
provided.

 23. Heat Map―Applies an effect to the image, giving it the 
appearance of a thermogram (Figure 3-65). The strength of 
the effect is controlled by the slider in the dialog box.

Figure 3-64. The Art Poster filter

Figure 3-65. The Heat Map filter
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 24. Tri Tone―Applies three color values to the highlights, 
midtones, and shadows of the image (Figure 3-66). The effect 
can be changed by using the Color Selector dialog box.

 25. Night Vision―Simulates the effect of viewing the image 
through an image intensifier used in low-light conditions 
(Figure 3-67). The Gain and Noise settings are controlled 
using the sliders in the dialog box.

Figure 3-66. The Tri Tone filter

Figure 3-67. The Night Vision filter
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 26. Emboss―Simulates the effect of viewing the image standing 
out as a relief (Figure 3-68).

 27. Engrave―Simulates the effect of viewing the image engraved 
on a hard object (Figure 3-69).

 28. Find Edges―Finds the edges in the image and creates a neon-
like effect (Figure 3-70).

Figure 3-68. The Emboss filter

Figure 3-69. The Engrave filter
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The View Menu
The View menu (Figure 3-71) provides several options for zooming in on the image, as 
well as viewing the Navigator, Layer, and History palettes (among others).

Here’s a look at the options available from the View menu:

•	 Zoom In (Control++)―Magnifies the image one level.

•	 Zoom Out (Control+-)―Zooms out from the image one level.

•	 Actual Pixels (Control+0)―Displays the image at a one image 
pixel to one monitor pixel ratio.

Figure 3-70. The Find Edges filter

Figure 3-71. The View menu
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•	 Show All (no shortcut)―Displays the image in its entirety within 
the workspace.

•	 Navigator (no shortcut)―Displays or hides the Navigator Palette.

•	 Layers (no shortcut)―Displays or hides the Layers Palette.

•	 History (no shortcut)―Displays or hides the History Palette.

 ■ Note We covered at the navigator, layers, and history palettes in Chapter 1.

•	 Tool Options (no shortcut)―Displays available options for the 
active tool.

•	 Fullscreen Mode (no shortcut)―The Pixlr Editor workspace 
occupies the entire monitor for maximum image display. To exit 
the fullscreen mode, press the Escape key.

•	 Reset Palette Location (no shortcut)―Places the palettes to their 
default positions if they’ve been moved.

 ■ Note Because pixlr editor is browser-based, some shortcuts may be overridden by the 
browser’s preset shortcuts.

The Language Menu
Pixlr Editor supports 28 different languages. The choices are shown in the Language 
menu (Figure 3-72).

http://dx.doi.org/10.1007/978-1-4842-2698-8_1
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The following languages are supported by Pixlr Editor:

•	 English

•	 Spanish

•	 German

•	 French

•	 Greek

•	 Arabic

•	 Brazilian

•	 Russian

•	 Ukrainian

•	 Hebrew

•	 Croatian

•	 Italian

•	 Romanian

•	 Dutch

•	 Swedish

Figure 3-72. The Language menu
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•	 Danish

•	 Finnish

•	 Slovenian

•	 Czech

•	 Turkish

•	 Polish

•	 Portuguese

•	 Indonesian

•	 Simplified Chinese

•	 Traditional Chinese

•	 Thai

•	 Japanese

•	 Korean

The Help Menu
The Pixlr Editor Help menu offers several avenues for obtaining help should you need it 
(Figure 3-73).

The following options are offered in the Help menu:

•	 Help, FAQ, and API―Link to the Pixlr support page at https://
support.pixlr.com/hc/en-us. From there, you can navigate 
using the corresponding link to the page you want to open.

•	 Blog―Links to the Pixlr Blog at http://pixlr.com/blog/. This is 
where you can connect with other users for help and tips.

•	 Contact―Allows you to submit a request for help via e-mail to the 
support team.

Figure 3-73. The Help menu

https://support.pixlr.com/hc/en-us
https://support.pixlr.com/hc/en-us
http://pixlr.com/blog/
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The Login/Sign Up Menu
This area is for users with a Pixlr account to log in, and for those who don’t to sign up for 
one if desired. When you log in, the dialog box opens with textboxes to enter your e-mail 
and password, or to sign in with Google (Figure 3-74).

Pixlr Editor can be used without an account, but you’ll only be able save images to 
your computer or external storage device. Keeping your images in the library offers the 
advantage of accessing them from any computer with an Internet connection. This can 
also prevent their loss in case of a hard drive failure.

To sign up, simply enter your name and e-mail address, and then create a password 
(Figure 3-75).

Figure 3-74. The Login dialog box
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Summary
In this chapter, we covered a lot of ground by exploring all of the functions contained  
in the menu bar. Many of the functions you’ll need in order to edit images are accessed 
from here.

This concludes Part I of this book―you had a thorough look at the Pixlr Editor 
workspace, tools, menu bar, and palettes. In the next chapter beginning in Part II, you’ll 
learn some image editing basics by learning how to compose good photos before pressing 
the shutter button, and how to improve composition in photos using Pixlr Editor.

Figure 3-75. The Sign Up dialog box



PART II

Working With Images
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CHAPTER 4

Composing Images

This chapter looks at making images look their best by using techniques for optimum 
composition. Here’s what you’ll learn:

•	 Start Out by Taking Well Composed Photos: In this portion, we’ll 
take a look at composing the image before the shutter is clicked.

•	 Using the Rule of Thirds: This part provides a basic guide to using 
the “rule of thirds”.

•	 Cropping: In this tutorial, we’ll learn to use the Crop tool 
effectively.

•	 Straightening Crooked Images: In this tutorial, we’ll learn how to 
straighten crooked images using Pixlr Editor.

•	 Correcting Perspective: In this tutorial, we’ll learn how to improve 
an image that suffer from distortion problems.

•	 Standard Photo Print Sizes: Discusses optimal resolution for 
achieving good print results and provides a guide for converting 
width and height measured in pixels to standard print sizes in 
inches.

Start Out by Taking Well Composed Photos
These days, just about everyone has a camera in some form—just think of the countless 
snapshots people capture using smart phones. Many people just point and shoot to 
capture an image on impulse (which can make for great photography, but sometimes that 
just requires good luck).

You can capture an otherwise great picture, but there may be unwanted objects or 
clutter in the background rendering your picture less than ideal. Pixlr Editor is a great tool 
for correcting such problems. However, capturing the image without the distractions and 
clutter will save you a lot of time and effort.

You’ll notice the image on the left in Figure 4-1 has several objects in the background 
making it appear cluttered. Pixlr Editor is a great tool for digitally removing clutter, as 
shown in the image on the right. Of course, using a clutter-free background is always the 
best option when possible. We’ll look at removing objects using Pixlr Editor in Chapter 8.

http://dx.doi.org/10.1007/978-1-4842-2698-8_8
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In Figure 4-2, a different background location was chosen in front of the same house 
(not perfect, but the best available at the location). Because there’s no clutter here, no 
digital cleanup is required, which is a huge time-saver.

Figure 4-1. Pixlr Editor is a great tool for digital clutter removal

Figure 4-2. Using a clutter-free background eliminates the need for digital clutter removal
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Using the Rule of Thirds
The “rule of thirds” is a general rule of composition used in photography. It uses a grid 
composed of nine square or rectangular units. The points where the lines intersect are 
used for positioning the elements of main interest.

In Figure 4-3, the image of the lifeguard shack is positioned using the guides—placing 
it off-center creates greater visual interest than if it were placed dead center in the image.

Figure 4-3. The intersecting points are used to help position elements of interest

Using the rule of thirds as a guide is helpful when composing landscape or seascape 
images. Generally, the horizon line is placed either in the upper or lower third of the grid. 
As you can see in Figure 4-4, the horizon line is positioned near the upper third of the grid 
because the foreground is the primary area of interest. Notice also where the cloud meets 
the peak rests along the left vertical line.

Figure 4-4. The horizon line is placed near the upper horizontal third of the grid, and 
where the cloud meets the peak is near the left vertical third
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The rule of thirds is a useful guide for photographing people as well. In Figure 4-5, 
the man is positioned along the right vertical guideline, with his eyes along the upper 
horizontal guideline.

Figure 4-5. The rule of thirds is helpful for composing interesting portraits of people

Figure 4-6. In this image, symmetry trumps the rule of thirds

You may be asking yourself if there are times you wouldn’t use the rule of thirds. 
Like most rules, there are times when it’s better to ignore it. In Figure 4-6, the image of the 
mountains and their reflections calls for symmetry and balance. In this case, using the 
horizontal axis as the guide results in a visually compelling image.
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 ■ Note  pixlr editor displays a “rule of thirds” grid when using the Crop tool to help with 
better composition when trimming images.

TUTORIAL 1: CROPPING AN IMAGE

Trimming Away Excess Image Data

sometimes, you just have to capture a good picture when the opportunity is there. 
Because you have to act quickly, the downside is you might capture unwanted 
objects or people along with it.

in this tutorial, you’ll use the Crop tool to better compose the image following the 
“rule of thirds”.

1. open the image titled Ch04_Little Girl.jpg found in the 
Ch04 Practice Images folder.

2. Upon looking at the photo, it’s easy to see that there are feet 
and legs in the background (Figure 4-7).

Figure 4-7. Legs and feet in the background of the image

3. Click the Crop tool or press C on your keyboard.

4. Click and drag to orient the picture in a portrait (vertical) format. 
Use the Crop tool’s grid to position as shown in Figure 4-8. the 
little girl should be off-center.
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5. once in position, activate the Crop tool by double-clicking in the 
image or pressing enter on your keyboard.

6. Create a new layer (Layer ➤ new Layer) and rename it Clone. 
this is done by double-clicking in the layer thumbnail’s textbox 
(Figure 4-9).

Figure 4-8. Use the Crop tool’s grid to position as shown

Figure 4-9. Double-click in the layer’s textbox to rename it
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7. Click the Clone stamp tool icon or press the letter s on your 
keyboard. Choose a soft brush between 50-70 pixels in 
diameter.

8. Click the sample all Layers checkbox in the tool options bar. 
this allows you to clone image data on this separate layer 
rather than directly on the background layer.

9. Click the Clone layer to make sure it is active and use the Clone 
stamp tool to remove the leg, foot, and shadow (Figure 4-10).

Figure 4-10. Use the Clone Stamp tool to remove the legs and feet in the background

10. Clone on the left side to remove the foot next to the little girl.

11. Figure 4-11 shows the before and after comparison. When 
finished, either close the image without saving or save it as a 
pXD file for future reference. If you are a student, your teacher 
may instruct you to save the image by a certain name and in a 
certain location (such as a flash drive).
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TUTORIAL 2: STRAIGHTENING AN IMAGE

Use Free Transform to Correct a Crooked Image

the Free transform function is very useful for straightening images with a tilt. in this 
tutorial, we’ll correct an image of an old church.

1. open the image titled Ch04_Church.jpg found in the Ch04 
Practice Images folder.

2. Duplicate the background layer (Layer ➤ Duplicate Layer).

3. activate the Free transform function (edit ➤ Free transform, or 
press Control+t) and position the cursor around the upper-right 
corner of the image until a curved arrow icon appears.

4. Click and drag, moving the duplicate layer slightly clockwise 
until the eave of the roof is level (Figure 4-12).

Figure 4-11. Before and after comparison
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5. Create a new layer (Layer ➤ new Layer) and rename it Clone 
using the layer thumbnail’s textbox.

6. Click the Clone stamp tool icon or press the letter s on your 
keyboard. Check the sample all Layers option.

7. Choose a soft brush between 50-70 pixels in diameter.

8. When the layer was straightened, some of the background layer 
became visible and is noticeable (like a seam).

9. Clone the areas indicated in the upper left and right to make a 
smooth transition, as well as the partial image of the car (left side) 
and the area in the lower-left corner (Figure 4-13).

Figure 4-12. Rotate the layer slightly until level
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10. Figure 4-14 shows the before and after comparison. When 
finished, either close the image without saving or save it as a 
pXD file for future reference. If you are a student, your teacher 
may instruct you to save the image with a certain name and in a 
certain location (such as a flash drive).

Figure 4-14. Before and after comparison

Figure 4-13. Use the Clone Stamp tool to cover the noticeable areas of the underlying layer
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TUTORIAL 3: CORRECTING PERSPECTIVE

Use Free Distort to Correct an Image with Perspective Problems

the Free Distort function can be useful for correcting images that suffer from 
camera lens distortion or perspective issues.

1. open the image titled Ch04_Perspective Correction.jpg 
found in the Ch04 Practice Images folder.

2. Duplicate the background layer (Layer ➤ Duplicate Layer).

3. activate the Free Distort function (edit ➤ Free Distort).

4. Drag the upper corners of the bounding box to the positions 
shown in Figure 4-15.

5. nudge the lower-right corner of the bounding box down very 
slightly (Figure 4-16).

Figure 4-15. Drag the upper corners of the bounding box into position as shown
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Figure 4-17. The triangular area will be filled in to complete the peak

6. Create a new layer (Layer ➤ new Layer) and rename it Clone 
using the layer thumbnail’s textbox.

7. Click the Lasso tool icon or press the letter L on your keyboard. 
Click the polygonal Lasso option checkbox.

8. make a triangular selection above the left peak (Figure 4-17).  
the Clone stamp tool will be used to fill it in. Zoom in as 
necessary.

9. Click the Clone stamp tool icon or press the letter s on your 
keyboard. Check the sample all Layers option.

10. Choose a soft brush 20 pixels in diameter.

11. sample the peak from the underlying layer and use the Clone 
stamp tool to fill in the selection on the layer named Clone.

12. When finished, press Control+D to deactivate the selection.

13. Use the Clone stamp tool to fill in the peak (Figure 4-18).

Figure 4-16. Drag the right corner of the bounding box to the position shown
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14. Use the Clone stamp tool to finish by removing the seam 
(Figure 4-19).

15. Figure 4-20 shows the before and after comparison. When 
finished, either close the image without saving or save it as a 
pXD file for future reference. If you are a student, your teacher 
may want you to save the image with a certain name and in a 
certain location (such as a flash drive).

Figure 4-18. Use the Clone Stamp tool to fill in the selection

Figure 4-19. Use the Clone Stamp tool to remove the appearance of the peak and seam 
from underlying layer
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Printing Standard Photo Sizes
Pixlr Editor was designed to output images for digital display, but it is possible to output 
them to your inkjet printer or have your local photo lab print them.

However, it’s important to work with an image of sufficient resolution. How much is 
enough? An image opened from a URL will likely be too small to obtain a good print from. If 
you scan photos with a flatbed scanner, scan at least at a setting of 300 PPI (pixels per inch).  
If you’re starting with a small original and plan to print it larger, use your scanner’s 
software to enlarge it to the desired target size.

Generally, transparencies such as slides and negatives must be scanned at higher 
resolutions than photographs when they are to be printed.

Most modern digital cameras capture 16 megapixels at least, providing enough data 
for good prints (when using the highest quality setting).

 ■ Note When outputting images as Jpeg files using pixlr editor, it’s a good idea to set the 
quality at 100% before saving.

Because an image opened in Pixlr Editor is measured in pixels, I’ve provided a guide 
to help convert from pixels to inches (Table 4-1).

Figure 4-20. Before and after comparison
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Summary
This chapter covered several basic techniques for achieving good image composition. 
Paying attention to the background while composing the image can eliminate clutter that 
might have to be digitally removed later. The “rule of thirds” is a widely accepted guide for 
making images more interesting.

The tutorials showed how to crop an image to make it look its best, use Free 
Transform to correct a crooked image, and use Free Distort to correct an image with 
perspective distortion.

This chapter also touched on the fact that to print an image, it’s important to make 
sure it has sufficient resolution. A guide converting dimensions from pixels to several 
standard print sizes is provided.

The next chapter covers using a variety of ways to correct image tonality.

Table 4-1. Conversion of Image Size from Pixels to Print Size in Inches

Image Size (Pixels) Print Size (Inches)

1050 X 1500 3.5 X 5

1200 X 1200 4 X 4

1200 X 1500 4 X 5

1200 X 1800 4 X 6

1500 X 2100 5 X 7

2400 X 3000 8 X 10
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CHAPTER 5

Improving Image Tonality

This chapter looks at correcting problems such as poor contrast and exposure issues. 
Here's what will be covered:

•	 Common Tonal Problems: In this part, we'll look at the most 
common tonal problems in photographic images.

•	 Using the Brightness and Contrast Adjustment: In this part, we'll 
take a look at how to improve tonality using this tool.

•	 Using Exposure: In this part, we look at how using the Exposure 
adjustment improves a dark, underexposed image.

•	 The Levels Adjustment: The Levels dialog box is a powerful  
(and fairly complex) tool used for image tonality adjustments. 
This part takes a close look at how it works.

•	 The Curves Adjustment: The Curves dialog box is another 
powerful, complex tool used for image tonality adjustments. This 
part takes a close look at how it works.

•	 Improving Exposure Using Layer Modes: This section looks at how 
image exposure can be improved by using two different layer 
blending modes.

•	 Local Tonal Adjustments Using the Dodge and Burn Tools: This 
section looks at how image tonality can be improved in parts of an 
image using these tools.
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Common Tonal Problems
Tonal problems are very common not only in casual photography, but in older images 
that have degraded over time. In many cases, a simple quick fix is all that's needed to 
correct the image. In other cases, you'll need to use more powerful adjustments such as 
Levels or Curves.

Tonal problems usually fall under one of the following descriptions:

•	 Low contrast (dull and flat)

•	 Underexposed (too dark)

•	 Mixed tonality (good exposure in some areas, poor exposure  
in others)

•	 Overexposed (too bright)

The rest of this chapter shows you various methods describing how to correct these 
issues using the adjustments (tutorials accompany some of them).

Using the Brightness & Contrast Adjustment 
Dialog Box
Tonal problems are very common not only in casual photography, but in older images 
that have degraded over time. In many cases, a simple quick fix is all that's needed to 
correct the image.

 ■ Note Just as you would compose an image in the best way possible before clicking the 
shutter button, it's also a good practice to follow your camera's user manual guidelines on 
how to achieve the best exposure before shooting the picture.
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The Brightness & Contrast adjustment is a basic tonal correction tool designed for 
making quick corrections. It doesn't offer the precise control found in the Levels and 
Curves dialog boxes, but will work well for many types of images with contrast problems. 
The image shown in Figure 5-1 is washed out and lacking in contrast.

Figure 5-1. This image is lacking in contrast
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Using the Exposure Adjustment Dialog Box
The Exposure adjustment is a useful function for making quick improvements in 
underexposed images. The inside of an old church turned out underexposed in this 
image (Figure 5-3).

Now the image is opened in Pixlr Editor, and by using the Brightness & Contrast 
dialog box (Adjustment ➤ Brightness & Contrast), the image is improved by setting the 
Brightness to -15 and the Contrast to 35 (Figure 5-2).

Figure 5-2. The tonal quality of this image is improved using the Brightness & Contrast 
adjustment



Chapter 5 ■ ImprovIng Image tonalIty

119

Figure 5-3. The image of this old church is underexposed

Figure 5-4. The Exposure adjustment quickly improves this underexposed image

By setting Exposure adjustment to 30, the image is quickly improved, and more 
detail is revealed (Figure 5-4). The Exposure adjustment ranges from 0-50.
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The Levels Adjustment Dialog Box
The Levels dialog box allows you to make an image lighter or darker, or to change the 
contrast. It offers more precise control than the Brightness & Contrast adjustment. Color 
corrections can also be made using Levels, which we'll look at in detail Chapter 6.

The Levels dialog box displays a histogram, which is a graphical representation of the 
pixel brightness values ranging from 0 (pure black) to 255 (pure white).

The tonal information of the black and white (grayscale) image of the car is mapped 
in the histogram shown in Figure 5-5. All of the darkest pixels are contained in the left 
portion of the histogram, the middle range pixels are in the center portion, and the 
lightest pixels are in the right portion.

Figure 5-5. The tonal information of this image is mapped in the histogram

TUTORIAL 4: TONAL CORRECTION USING LEVELS

Improving Contrast in a Dull Image

the levels adjustment is very useful for correcting tonality in images. In this tutorial, 
levels will be used to remap the tonality to improve the contrast in a dull and flat 
image.

1. open the image titled Ch05_Lady and Baby.jpg found in the 
Ch05 Practice Images folder.

2. Duplicate the background layer (layer ➤ Duplicate layer).

3. rename the duplicate layer Contrast Fix using the layer 
thumbnail’s textbox.

http://dx.doi.org/10.1007/978-1-4842-2698-8_6
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4. open the levels dialog box (adjustment ➤ levels). note that 
most of the tonal information is clustered in the midtones range 
of the histogram―the dark and light ranges are lacking.

5. In the Input levels window, move the left black point slider 
toward the center where the histogram data begins―repeat 
this process moving the right white point slider toward the 
histogram data (Figure 5-6). Click oK when you’re done.

Now the image is has much better contrast, as seen in the before and after 
comparison (Figure 5-7). When you’re finished, either close the image without saving or 
save it as a PXD file for future reference. If you are a student, your teacher may instruct you 
to save the image with a certain name and in a certain location (such as a flash drive).

Figure 5-6. Moving the black and white point sliders remaps the tonality in the image to 
improve contrast

Figure 5-7. Before and after comparison
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Using the Levels Mid Point Slider
In the previous tutorial, the contrast was improved by using the black point and white 
point sliders to remap the tonality. These sliders make adjustments to the darkest and 
lightest ranges in the image.

The mid point slider (also called the gamma slider) is useful for revealing detail in 
images that are moderately underexposed. The mid point slider produces results similar 
to those that the Exposure adjustment dialog box does.

TUTORIAL 5: EXPOSURE CORRECTION USING LEVELS

Improving an Underexposed Image

this tutorial involves only a couple of slight adjustments, but they make a noticeable 
difference.

1. open the image titled Ch05_Little Grand Canyon.jpg found 
in the Ch05 Practice Images folder.

2. Duplicate the background layer (layer ➤ Duplicate layer).

3. rename the duplicate layer Exposure Fix using the layer 
thumbnail’s textbox.

4. open the levels dialog box (adjustment ➤ levels). note that 
most of the tonal information is clustered in the darker range of 
the histogram.

5. In the Input levels window, move the white point slider toward the 
point where the histogram data begins (the numeric value should read 
243). move the mid point slider slightly to the left until the numeric 
value reads 0.8 (Figure 5-8). Click oK when you’re done.

Figure 5-8. Making a slight exposure correction using the white point and mid point sliders
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Now the image is a bit lighter—note a little more detail is revealed in the darker areas 
of the image (Figure 5-9). When you’re finished, either close the image without saving or 
save it as a PXD file for future reference. If you are a student, your teacher may instruct you 
to save the image with a certain name and in a certain location (such as a flash drive).

The Curves Adjustment Dialog Box
The Curves dialog box is a powerful function that allows you to make precision 
adjustments in your image. Depending on the type of adjustment being made, the 
diagonal line is moved in specific areas, or parts of the line can be anchored to prevent 
changes in certain parts of the image (Figure 5-10).

Figure 5-9. Before and after comparison

Figure 5-10. Adjustments are made by moving the diagonal line in specific areas
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By default, the histogram is not shown, but you can display it by checking the 
Histogram option box (which I recommend, since the histogram is a “map” of the tonal 
information).

TUTORIAL 6: TONAL CORRECTION USING CURVES

Improving Contrast in a Dull Image

In this tutorial, the contrast of a tonally flat image will be boosted with a commonly 
used method in the world of image editing known as an “S” curve.

1. open the image titled Ch05_Flat Cat.jpg found in the Ch05 
Practice Images folder.

2. Duplicate the background layer (layer ➤ Duplicate layer).

3. rename the duplicate layer Contrast Fix using the layer 
thumbnail’s textbox.

4. open the Curves dialog box (adjustment ➤ Curves). Check the 
histogram option box.

5. note that most of the tonal information is clustered in the mid 
range area of the histogram.

6. Click in the center of the grid to place an anchor point (Figure 5-11).  
Do not click oK just yet.

Figure 5-11. Click the center to place an anchor point
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7. now, place points on the line and move as shown in Figure 5-12 
(note that it bears a slight resemblance to the letter “S”). Click 
oK when you’re done.

 ■ Note the purpose of this tutorial is to get you accustomed to making manual 
adjustments using Curves. however, there is an Increase Contrast setting in the Curves 
presets. Some of the Curves presets will be covered in more depth in Chapter 6.

Now the contrast is boosted and the image is improved (Figure 5-13). When you’re 
finished, either close the image without saving or save it as a PXD file for future reference. 
If you are a student, your teacher may instruct you to save the image with a certain name 
and in a certain location (such as a flash drive).

Figure 5-12. Contrast is improved using an “S” curve

Figure 5-13. Before and after comparison

http://dx.doi.org/10.1007/978-1-4842-2698-8_6
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TUTORIAL 7: PARTIAL EXPOSURE CORRECTION  
USING CURVES

Improving an Image with Mixed Tonality

In this tutorial, Curves will be used to create a fill flash effect. It will lighten the 
harsh, darker areas of the image while not affecting the lighter areas.

1. open the image titled Ch05_Hiker at Rest.jpg found in the 
Ch05 Practice Images folder.

2. Duplicate the background layer (layer ➤ Duplicate layer).

3. rename the duplicate layer Exposure Fix using the layer 
thumbnail’s textbox.

4. open the Curves dialog box (adjustment ➤ Curves). Check the 
histogram option box. note that most of the tonal information is 
clustered in the mid range and dark range areas of the histogram.

5. place anchor points along the line, as shown in Figure 5-14. 
this will “lock down” the pixels in the lighter-to-lightest range 
of the image. Do not click oK just yet.

Figure 5-14. Placing this anchor point “locks down” the light to lightest pixels
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Figure 5-15. Making this adjustment reduces the harsher dark areas

6.  Click on the line and pull upward to form a bow shape, as shown in  
Figure 5-15. Click oK when you’re done.

The effect reduces the harsh shadows, while keeping the lighter areas from washing 
out (Figure 5-16). When you’re finished, either close the image without saving or save it as 
a PXD file for future reference. If you are a student, your teacher may instruct you to save 
the image with a certain name and in a certain location (such as a flash drive).

Figure 5-16. Before and after comparison
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 ■ Note In the next chapter, we'll look at the commands (represented by eyedropper  
icons in the Curves dialog box) to set the white, gray, and black points for color-correcting 
an image.

Improving Exposure Using Layer Modes
Using layer modes (particularly Multiply and Screen) can be useful for quickly correcting 
images that are overexposed or underexposed.

Figure 5-17 is an example of a slightly overexposed image.

Figure 5-17. A slightly overexposed scenic image



Chapter 5 ■ ImprovIng Image tonalIty

129

By duplicating the background layer and changing the mode to Multiply, the image 
is much less washed out. The layer’s opacity was lowered to 80% to achieve the result 
shown in Figure 5-18.

Figure 5-18. The overexposed image corrected using the Multiply layer mode

TUTORIAL 8: EXPOSURE CORRECTION USING THE 
SCREEN LAYER MODE

Improving an Underexposed Image

Just as using the multiply layer mode improved the overexposed image, the Screen 
mode can improve underexposed images.

1. open the image titled Ch05_Dark Ship.jpg found in the  
Ch05 Practice Images folder.

2. Duplicate the background layer (layer ➤ Duplicate layer).

3. rename the duplicate layer Exposure Fix using the layer 
thumbnail's textbox.
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Figure 5-20. Duplicate the layer named Exposure Fix twice, then lower the opacity to 50% 
on the uppermost layer copy

Figure 5-19. Changing the layer mode from Normal to Screen

4. Change the layer mode to Screen. this is done by clicking 
toggle layer settings, then changing the mode from normal to 
Screen (Figure 5-19).

5. this image is better, but will need further correction. Duplicate 
the exposure Fix layer (layer ➤ Duplicate layer) two times. 
lower the opacity of the top layer to 50% (Figure 5-20).
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the exposure of this image now looks more like it should (Figure 5-21). When 
you’re finished, either close the image without saving or save it as a pXD file 
for future reference. If you are a student, your teacher may instruct you to save 
the image with a certain name and in a certain location (such as a flash drive).

Local Tonal Adjustments Using the Dodge and 
Burn Tools
Some images might need tonal corrections only in specific (or local) areas. The Dodge 
and Burn tools are used for this purpose. As shown in Figure 5-22, the Dodge tool is being 
used to lighten the opening in the brick wall, revealing some detail.

Figure 5-21. Before and after comparison

Figure 5-22. Using the Dodge tool to lighten the opening
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 ■ Note In addition to the upcoming tutorial, you can also refer to the Tools Tryout Guide 
and Practice Images folder, which can be obtained from the Source Code/Downloads tab 
from this apress page: http://www.apress.com/9781484226971.

TUTORIAL 9: USING THE BURN TOOL

Darkening Parts of an Image

In this tutorial, the Burn tool will be used to darken part of a hazy image.

1. open the image titled Ch05_Castle.jpg found in the Ch05 
Practice Images folder.

2. Duplicate the background layer (layer ➤ Duplicate layer).

3. rename the duplicate layer Exposure Fix using the layer 
thumbnail’s textbox.

4. Click the Burn tool icon and select a brush 200 pixels in 
diameter with a hardness of 50%.

5. Select the midtones option and set the exposure to 50%

6. Work along the top of the hazy part of the castle (Figure 5-23).

7. make short strokes, so if you need to undo any mistakes, it 
won’t reverse too much of your work.

Figure 5-23. The Burn tool will darken the hazy portion of this image

http://www.apress.com/9781484226971.
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Using the Burn tool in the hazy area now makes the image look more evened out 
(Figure 5-24). When you’re finished, either close the image without saving or save it as a 
PXD file for future reference. If you are a student, your teacher may instruct you to save the 
image with a certain name and in a certain location (such as a flash drive).

Summary
This chapter covered several methods for correcting tonal problems. The Brightness 
& Contrast adjustment dialog box is a basic tool that works well in many cases, but 
has limits. The Exposure adjustment dialog box is a quick method for improving 
underexposed images.

The Levels and Curves adjustment dialog boxes (while being more complex) offer 
more control in the tonal adjustments being made.

The Multiply and Screen layer modes can be used to improve images that are 
overexposed or underexposed, respectively.

The Dodge and Burn tools are used to make local tonal adjustments.
The next chapter covers a variety of color correction methods.

Figure 5-24. Before and after comparison



135© Phillip Whitt 2017 
P. Whitt, Beginning Pixlr Editor, DOI 10.1007/978-1-4842-2698-8_6

CHAPTER 6

Color Adjustments

This chapter looks at several methods of adjusting and correcting color, and several 
Curves presets for creative effects.

•	 The RGB Color Model and Color Channels: This part briefly 
looks at the RGB color model (which Pixlr Editor uses) and color 
channels.

•	 Using the Color Balance Adjustment Dialog Box: In this part, we’ll 
look at correcting a color imbalance using this dialog box.

•	 Using the Levels Adjustment Dialog Box: In this part, we’ll look at 
restoring faded colors by using Levels on each color channel.

•	 Using the Curves Adjustment: In this part, we’ll look at making a 
color correction using Curves.

•	 Using the Curves Presets: This part looks at the Curves presets, 
used for making quick tonal changes, and color adjustments for 
artistic effect.

The RGB Color Model and Color Channels
Before moving on to the tutorial (in which some of the adjustments will be a bit more 
involved), let’s learn a little bit about the RGB color model and color channels. Pixlr Editor 
uses the RGB color model, which mixes red, green, and blue light in various amounts to 
create a broad array of colors that are displayed on your monitor. When red, green, and 
blue light is combined at 100%, the result is white (Figure 6-1). Conversely, when there is 
zero percentage of each, black is the result.
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An image displayed on your monitor in the RGB color model is comprised of three 
channels; one red, one green, and one blue. Put in its simplest terms, channels are 
essentially storage containers for the lightness value information of each color (Figure 6-2). 
The examples shown have been converted to grayscale for easier viewing.

It’s making adjustments in one or more color channels that alters the image’s look. 
This is usually done indirectly by using the various adjustment functions Pixlr Editor has 
to offer. However, the Levels and Curves adjustments provide more direct control over 
each channel (we’ll see an example of using Levels for this purpose in Tutorial 11 coming 
up a little later).

Using the Color Balance Adjustment Dialog Box
An image with a color cast (excessive tint of an undesired color) can often be easily 
corrected with this adjustment. It works by increasing more of the (unwanted) color’s 
opposite, thus balancing it out. Figure 6-3 shows the Color Balance dialog box, and the 
corresponding colors and their opposites, which is controlled by using the sliders.

Figure 6-1. Red, green, and blue light combined at 100% results in white

Figure 6-2. Color channels store lightness value information of each color
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TUTORIAL 10: COLOR CORRECTION USING COLOR 
BALANCE

Removing a Color Cast

In this tutorial, we’ll use the Color Balance dialog box to correct an image with a blue 
color cast that resulted from poor processing by the film lab.

1. open the image titled Ch06_Mr.Cash.jpg found in the Ch06 
Practice Images folder.

2. duplicate the background layer (layer ➤ duplicate layer).

3. rename the duplicate layer Color Fix using the layer 
thumbnail’s textbox.

4. open the Color Balance dialog box (adjustment ➤ Color 
Balance).

5. move the Blue offset slider to the left until the numerical reading 
is -30 (Figure 6-4). this increases the yellow, offsetting the 
excess blue tint.

Figure 6-3. The Color Balance dialog box corrects a color cast by increasing more of the 
unwanted color’s opposite
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Now, the blue tint is removed and the colors are more balanced (Figure 6-5). When 
you’re finished, either close the image without saving or save it as a PXD file for future 
reference. If you are a student, your teacher may instruct you to save the image with a 
certain name and in a certain location (such as a flash drive).

Using the Levels Adjustment Dialog box
A common problem that affects older color photographs is the reduction of vibrance due 
to the dyes fading and shifting over time. Provided the dyes haven’t faded too much, the 
Levels dialog box can be very useful for correcting this problem.

Figure 6-4. Moving the Blue offset slider to the left increases the yellow

Figure 6-5. Before and after comparison
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TUTORIAL 11: COLOR RESTORATION USING LEVELS

Restoring Faded Colors Image Using Levels on Each Color 
Channel

this tutorial involves adjustments made to each color channel to achieve the final 
result.

1. open the image titled Ch06_Girl Gone Fishing.jpg found in 
the Ch06 Practice Images folder.

2. duplicate the background layer (layer ➤ duplicate layer).

3. rename the duplicate layer Color Fix using the layer 
thumbnail’s textbox.

4. open the levels dialog box (adjustment ➤ levels).

5. Click the triangle to the right of the Channel option dialog box. 
scroll down to highlight the red channel (Figure 6-6). Do not 
click OK just yet.

Figure 6-6. Highlight the Red channel option
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6. move the black point slider toward the center, stopping where 
the histogram data begins. repeat this step with the white point 
slider (Figure 6-7). Do not click OK just yet.

7. Click the triangle again to open the Channel option dialog  
box—scroll down to highlight the green channel (Figure 6-8). 
Do not click OK just yet.

Figure 6-7. Adjusting the black and white point sliders in the red channel
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8. move the black point slider toward the center, stopping where 
the histogram data begins. repeat this step with the white point 
slider (Figure 6-9). Do not click OK just yet.

Figure 6-8. Highlighting the Green channel

Figure 6-9. Adjusting the black and white point sliders in the green channel
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9. Click the triangle again to open the Channel option dialog box—
scroll down to highlight the blue channel (Figure 6-10). Do not 
click OK just yet.

10. move the black point slider toward the center, stopping where 
the histogram data begins. repeat this step with the white point 
slider (Figure 6-11). Click the OK button when you’re done.

Figure 6-10. Highlighting the Blue channel
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Now that the tonality of each color channel has been adjusted, the colors of the 
image are more vibrant, and the contrast is improved (Figure 6-12). When you’re finished, 
either close the image without saving or save it as a PXD file for future reference. If you are 
a student, your teacher may instruct you to save the image with a certain name and in a 
certain location (such as a flash drive).

Figure 6-11. Adjusting the black and white point sliders in the blue channel

Figure 6-12. Before and after comparison
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Using the Curves Adjustment Dialog Box
In the previous chapter, the Curves dialog box was used for making tonal corrections.  
In the upcoming tutorial, it will be used to make a tonal and color correction.

TUTORIAL 12: SETTING THE GRAY POINT USING CURVES

Removing a Color Cast Using Curves—Finishing with the 
Sponge Tool and Unsharp Mask

In this tutorial, the image has a predominate magenta color cast, with a bit of excess 
blue in the penguins. We’ll correct this by setting the gray point using the middle 
eyedropper option in the Curves dialog box.

then, we’ll apply the finishing touches using the sponge tool and unsharp mask.

1. open the image titled Ch06_Penguins.jpg found in the Ch06 
Practice Images folder.

2. duplicate the background layer (layer ➤ duplicate layer).

3. rename the duplicate layer Color Fix using the layer 
thumbnail’s textbox.

4. open the Curves dialog box (adjustment ➤ Curves). Check the 
histogram option box.

5. Click the middle (gray point) eyedropper icon.

6. Click in the target area indicated a few times (Figure 6-13). the 
goal is to achieve a result close to the one shown in the middle 
panel, so this may take repeated attempts. Rather than close 
the Curves dialog box (only to relaunch it), reset it to Default in 
the Presets options to start over. Click oK when you’re done.
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 ■ Note Ideally, the green channel’s adjustment curve should bow upward slightly 
(increasing green to offset the magenta), and the blue adjustment curve should bow 
downward slightly (increasing yellow to offset the blue). Your results may vary slightly, but if 
the image is close to the one shown, it should suffice.

7. the penguin on the right still has a tinge of blue. Click the 
sponge tool icon or press the letter p on your keyboard.

8. From the Brush options dialog box, select the soft, 200 pixel 
diameter brush.

9. select the desaturate option and set the strength to 9-10.

10. Brush along the wing, as shown in Figure 6-14, to reduce the 
blue tinge.

Figure 6-13. Set the gray point by using the middle eyedropper option and sampling the 
area indicated in the left panel

Figure 6-14. Use the Sponge tool to reduce the blue tinge
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11. Because the picture was taken through a glass window, the 
clarity may have been slightly diminished. open the unsharp 
mask filter (Filter ➤ unsharp mask).

12. set the amount to 110 and the radius to 3 (leave the threshold 
on the default setting of 15). this will sharpen the image just 
slightly (Figure 6-15).

13. Click oK when you’re finished.

The image now looks more color-balanced and crisper (Figure 6-16).

Figure 6-16. Before and after comparison

Figure 6-15. The Unsharp Mask filter sharpens the image slightly
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When you’re finished, either close the image without saving or save it as a PXD file 
for future reference. If you are a student, your teacher may instruct you to save the image 
with a certain name and in a certain location (such as a flash drive).

 ■ Note  the eyedropper options in Curves are used to expand the tonal range in your 
image by setting the black, gray, or white points. It takes some experimentation, but in my 
experience setting the gray point works well most color correction situations.

The Curves Presets
There are a number of presets available to you in the Curves adjustment dialog box. Some 
make tonal changes, while others primarily affect color.

•	 Default—Used to apply manual changes (Figure 6-17).

•	 Invert—Reverses the colors and lightness values (Figure 6-18).

Figure 6-17. The Default preset
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•	 Colder—Slightly increases blue and green, giving the image a cool 
tone (Figure 6-19).

•	 Warmer—Slightly increases red and yellow, giving the image a 
warm tone (Figure 6-20).

Figure 6-18. The Invert preset

Figure 6-19. The Colder preset
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•	 Increase Contrast—Automatically creates an S curve, boosting the 
contrast (Figure 6-21).

•	 Decrease Contrast—Automatically creates a “reverse S curve,” 
creating a flatter tone (Figure 6-22).

Figure 6-20. The Warmer preset

Figure 6-21. The Increase Contrast preset
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•	 Darken Shadows—Automatically darkens the dark to black range 
of pixels (Figure 6-23).

•	 Chillauto—Increases blue and slightly increases green and cyan 
for a cool tone (Figure 6-24).

Figure 6-22. The Decrease Contrast preset

Figure 6-23. The Darken Shadows preset
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•	 Cross Process—Mentioned in the Adjustments section of Chapter 3, 
this mimics the technique of purposely processing one film type using 
a photographic chemical intended for another film type (Figure 6-25).

•	 These are just the first nine presets—if you scroll further down 
you’ll discover many more (Figure 6-26).

Figure 6-24. The Chillauto preset

Figure 6-25. The Cross Process preset

http://dx.doi.org/10.1007/978-1-4842-2698-8_3
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Summary
This chapter described several techniques for correcting and adjusting color. We first 
covered (very briefly) how RGB images are comprised of red, green, and blue light. Color 
channels are essentially storage containers for lightness value information for each color.

The Color Balance adjustment works by increasing the offending color’s opposite to 
balance it out (such as a blue color cast being corrected by increasing yellow).

The Levels dialog was used to adjust each color channel to restore the vibrance to a 
faded color image.

The Curves dialog was used to set the gray point of an image with a magenta color 
cast. The Sponge tool was used to reduce the blue tinge in a local area, and the Unsharp 
Mask filter was used to sharpen the image slightly.

Lastly, we looked at the various tonal and color adjustments available from the 
Curves presets.

The next chapter looks at retouching and repairing photos using Pixlr Editor.

Figure 6-26. The remaining Curves presets
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CHAPTER 7

Photo Retouching and 
Repair

Pictures quite often have flaws that digital correction can drastically improve. In some 
cases, the culprit are imperfections such as red eye or skin blemishes. Other times, the 
photo may have incurred physical damage over time. This chapter looks at techniques for 
retouching and repairing flawed and damaged images. Here’s what we’ll cover:

•	 Red Eye Correction: This part looks at the Red Eye Reduction tool 
and how it works its magic

•	 Touching Up Blemishes Using the Spot Heal Tool: In this part, we’ll 
see how effective this tool is for clearing up facial blemishes.

•	 Repairing Damage Using the Spot Heal and Clone Stamp Tools: 
In this part, we’ll tackle repairing an image that has sustained a 
collection of scratches, punctures, and creases over time.

•	 Reducing Digital Noise: In this part, you’ll see how images with 
excessive noise can be improved.

Red Eye Correction
Everyone has seen them—those demon-like red eyes that become that can spoil an 
otherwise good picture. Red eye is caused by the camera’s flash reflected off the retina of 
the eye when the picture is taken in ambient light (the pupils are open wide, allowing a 
large amount of light to enter). The red color is the result of blood-rich choroid, which is 
connective tissue that lies behind the retina.

Fortunately, the Red Eye Reduction tool can quickly come to the rescue. In most 
cases, it works fine by itself. However, it only does what the name implies—reduces the 
effect without completely fixing it. Sometimes, the red eye effect is severe enough to 
require several extra steps and tools to end up with more natural results, as you’ll see 
shortly.
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TUTORIAL 13: RED EYE CORRECTION

Correcting Severe Red Eye Using Multiple Tools

in this tutorial, we’ll correct an image of a little boy with severe red eye.

1. open the image titled Ch07_Red Eye.jpg found in the Ch07 
Practice Images folder.

2. duplicate the background layer (Layer ➤ duplicate Layer).

3. Click the red eye reduction tool icon.

4. Click in the center of each eye in the duplicate layer. i used 
the default tolerance setting of 50%, but you can increase this 
slightly if needed (Figure 7-1).

 ■ Note after applying the tool, the eyes look much better (and we could stop here and call 
it finished), but there are several steps we can take to make them look more natural—let’s 
continue.

Figure 7-1. Using the Red Eye Reduction tool to remove the red
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5. We’ll need to make a couple of local tonal adjustments in the 
child’s left eye. Click the Burn tool icon or press the letter n on 
your keyboard.

6. Select the soft, 25-pixel diameter brush from the presets and 
leave the range and exposure at their default settings.

7. Brush the lighter part of the left eye until it matches the darker 
outer portion (Figure 7-2).

8. now we need to lighten the iris portion of the eyes (the outer 
area surrounding the pupils). Click the dodge tool icon or press 
the letter o on your keyboard.

9. Select the soft, 15-pixel diameter brush from the presets and 
change the range to Shadows and exposure to 20.

10. Brush around the pupils to lighten the iris, as shown in Figure 7-3.

Figure 7-2. Using the Burn tool to darken the pupil area of the left eye
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11. Create a new layer (Layer ➤ new Layer). Click the toggle Layer 
Settings icon and change the Mode to overlay.

12. rename the layer Eye Color using the layer thumbnail’s 
textbox.

13. Click in the Set Main Color swatch to open the Color Selector 
dialog box. Select a light blue using the numeric inputs: r-0, 
g-191, and B-255 (Figure 7-4). Click oK when you’re done.

Figure 7-3. Using the Dodge tool to lighten the area around the pupils
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14. Click the Brush tool (or press B on your keyboard).

15. Select the soft, 20-pixel diameter brush from the presets.

16. Brush around the pupils to apply the eye color. Lower the layer’s 
opacity to about 15% (Figure 7-5).

Figure 7-4. Launch the Color Selector dialog box and use the numeric settings shown to 
achieve a light blue
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The final result should be close to that shown in Figure 7-6. As mentioned, in many 
cases the Red Eye Reduction tool will suffice without extra measures, but when it doesn’t, 
you’ll now know how to handle those extreme cases of the red eye effect.

Figure 7-5. Applying the eye color with the Brush tool
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When you’re finished, either close the image without saving or save it as a PXD file 
for future reference.

If you are a student, your teacher may instruct you to save the image with a certain 
name and in a certain location (such as a flash drive).

Touching Up Blemishes
Touching up images with facial blemishes is a very common service provided by 
professional photographers and retouch artists. Pixlr Editor has a powerful weapon to 
use against blemishes (at least in photographic images), and that is the Spot Heal tool, as 
you’ll see in the lesson that follows.

TUTORIAL 14: BLEMISH TOUCH UP

Removing Blemishes Using the Spot Heal Tool

in this tutorial, we’ll remove quickly remove the largest, most obvious blemishes 
using the Spot heal tool.

1. open the image titled Ch07_Great Grandpa.jpg found in the 
Ch07 Practice Images folder.

2. duplicate the background layer (Layer ➤ duplicate Layer).

Figure 7-6. Before and after comparison
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3. rename the duplicate layer Heal Layer using the layer 
thumbnail’s textbox.

4. Click the Spot heal tool icon, set the brush diameter to about  
20 pixels, and make sure the Blend nearby option is checked.

5. Zoom in close enough to view comfortably. Starting at the top of 
the head, click over the larger blemishes (Figure 7-7). they should 
disappear seamlessly, but if not undo the step and try again.

 ■ Note the brush size should be only slightly larger than the blemish, so adjust as 
needed.

Figure 7-7. Use the Spot Heal tool starting at the top of the head



Chapter 7 ■ photo retouChing and repair

161

7. as you’re working, zoom out occasionally to monitor your 
progress (Figure 7-9). toggle the duplicate layer’s visibility off 
and on to compare the original to the work in progress.

Figure 7-8. Work downward along the face

6. Work down along the side of the face, as shown in Figure 7-8.
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The end result should resemble that shown in Figure 7-10. As you can see, the Spot 
Heal tool is extremely useful. When you’re finished, either close the image without saving 
or save it as a PXD file for future reference. If you are a student, your teacher may instruct 
you to save the image with a certain name and in a certain location (such as a flash drive).

Figure 7-9. Zoom out occasionally and toggle the layer’s visibility to monitor your progress 
as you work
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Removing Scratches and Damage
Repairing damage is another popular service provided by retouch artists. In the 
forthcoming lesson, we’ll repair a photo that has incurred some damage over time 
because of poor storage practices. We’ll be using both the Spot Heal and Clone Stamp 
tools for this assignment.

TUTORIAL 15: REMOVING SCRATCHES AND DAMAGE

Repairing a Photo Using the Spot Heal Tool and  
the Clone Stamp Tool

although the Spot heal tool is generally used for removing skin imperfections, it can 
be used for repairing scratches and other types of damage. the downside is that it 
doesn’t always work (it largely depends on the image content). in instances when it 
doesn’t work, the Clone Stamp tool can take over, as you’ll soon see.

 ■ Note it’s a good idea to review the Clone Stamp tool section of the supplemental Tools 
Tryout Guide and Practice Images folder, which can be obtained from the Source Code/
downloads tab from this apress page: http://www.apress.com/9781484226971.

Figure 7-10. Before and after comparison

http://www.apress.com/9781484226971
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1. open the image titled Ch07_Scratched Riverboat Ride.jpg 
found in the Ch07 Practice Images folder.

2. duplicate the background layer (Layer ➤ duplicate Layer) and 
rename it Heal Layer using the layer thumbnail’s textbox.

3. Create a new layer (Layer ➤ new Layer). rename the layer 
Clone Layer using the layer’s textbox. (it won’t be used just 
yet, so click the duplicate background layer to make it active.)

4. Click the Spot heal tool icon, set the brush diameter to about 30 
pixels, and make sure the Blend nearby option is checked.

5. remove the three puncture marks on the heal Layer layer 
(Figure 7-11) using the Spot heal tool.

6. use the Spot heal tool on the scratches (indicated in yellow) 
shown in Figure 7-12 on the heal Layer. the default brush 
diameter is 10 pixels—if necessary, increase the diameter 
slightly.

Figure 7-11. Remove the puncture marks shown
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7. Click the Clone Layer to activate it.

8. Click the Clone Stamp tool icon or press the letter S on your 
keyboard. Make sure the Sample all Layers option is checked.

9. repair the areas indicated in blue using the Clone Stamp tool. 
Be sure to re-sample often (Control+Click) as you work to avoid 
repeating patterns.

 ■ Note using the Spot heal tool in one stroke over areas with distinctive tonal differences 
(such as where the shadow of the bench and the sunlit deck surface meet) usually ends up 
with smudged results. that’s the purpose of using the Clone Stamp tool in those transitional 
areas.

10. Continue the process, working upward, as shown in Figure 7-13. 
Be sure to activate the corresponding layer when switching 
from one tool to another.

Figure 7-12. Use the Spot Heal tool on the areas indicated in yellow
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11. use the Clone Stamp tool on the remaining scratches, the tear, 
and the crease indicated in blue (Figure 7-14).

Figure 7-13. Continue the process working upward

Figure 7-14. Use the Clone Stamp tool on the remaining scratches, the tear, and the crease
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12. Choose the soft, 9-pixel diameter brush from the presets and 
finish by removing the remaining specks and dust (Figure 7-15).

 ■ Note Be sure to zoom in and look all around the image using the navigator to make 
sure everything is cleaned up.

When you’re finished, the result is an image that looks almost new (Figure 7-16). 
This type of work is time consuming, but can work wonders when repairing damaged 
photos—the key to making undetectable repairs is practice. When you’re finished, either 
close the image without saving or save it as a PXD file for future reference. If you are a 
student, your teacher may instruct you to save the image with a certain name in and a 
certain location (such as a flash drive).

Figure 7-15. Use the Clone Stamp tool to finish the remaining specks

Figure 7-16. Before and after comparison
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Reducing Image Noise
Image noise is an undesirable by-product that has a gritty appearance. It usually results 
from from taking pictures in low light situations. Pixlr Editor’s Denoise Filter helps 
smooth the image’s appearance. The Denoise Filter is a “one shot” filter—it does not 
offer a dialog box with additional options, but it can be applied repeatedly. However, its 
effectiveness will be limited on images with excessive noise.

TUTORIAL 16: REDUCING IMAGE NOISE

Using the Denoise Filter

1. open the image titled Ch07_Noisy Image.jpg found in the 
Ch07 Practice Images folder.

2. duplicate the background layer (Layer ➤ duplicate Layer) 
and rename it Noise Reduction using the layer thumbnail’s 
textbox.

3. Zoom in to see the noise more closely (Figure 7-17).

4. apply the denoise filter (choose Filter ➤ denoise) twice.

Figure 7-17. A close-up view of image noise
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This process won’t magically turn a poor quality, noisy image into a beautiful photo, 
but it will improve it to some extent (Figure 7-18). When you’re finished, either close the 
image without saving or save it as a PXD file for future reference. If you are a student, your 
teacher may instruct you to save the image with a certain name and in a certain location 
(such as a flash drive).

Summary
This chapter described several techniques for retouching and improving images with 
various imperfections.

The Red Eye Reduction tool is very useful for correcting the red eye effect caused by 
the camera flash. As you learned in the tutorial, in some cases extra steps are necessary to 
make the eyes look more natural.

In the tutorial featuring the elderly man holding his great-grandchild, the Spot Heal 
tool was used to remove the blemishes from his face.

Next, both the Spot Heal tool and the Clone Stamp tool were used to repair and clean 
up an image damaged by scratches, a tear, a crease, and dust specks.

The last thing we covered was using the Denoise filter to improve the appearance of 
an image with excessive digital noise.

The next chapter covers altering images by digitally removing unwanted elements 
and replacing backgrounds.

Figure 7-18. Before and after comparison
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CHAPTER 8

Removing/Adding Elements  
and Background 
Replacement

In Chapter 4, we learned the importance of composing a good image before snapping the 
picture. When this rule is practiced, it can eliminate the need to make digital alterations 
that could have been avoided.

Of course, sometimes these situations can’t always be avoided•when they can’t, Pixlr 
Editor can be used to modify the image.

In this chapter, we’ll learn the following:

•	 Removing Unwanted Elements: In this part, we’ll learn how to 
improve an image by removing unnecessary objects.

•	 Adding Elements: In this part, we’ll digitally add a second bird to 
the image being worked with throughout this chapter.

•	 Background Replacement: This part will demonstrate how to 
switch a so-so background to one with more appeal.

Removing Unwanted Elements
In this tutorial, we’ll learn how to remove some distracting objects from an image.

TUTORIAL 17: REMOVING DISTRACTING ELEMENTS

Borrowing Image Data to Cover Unwanted Objects

To do this exercise, follow these steps:

1. Open the image titled Ch08_Macaw.jpg found in the Ch08 
Practice Images folder.

http://dx.doi.org/10.1007/978-1-4842-2698-8_4
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2. Click the lasso tool icon (or press l on your keyboard).

3. set the Feather radius to 15 in the tool options bar. This will help 
the copied image data of the foliage to blend in better.

4. make a selection around some of the foliage just above the 
feeder (Figure 8-1).

5. Copy (choose edit ➤ Copy) and paste (edit ➤ paste) the 
selected area to a new layer.

6. Click the move tool icon, then move the copied image data over 
the feeder (Figure 8-2).

Figure 8-1. Use the Lasso tool to make a selection around some of the foliage just above  
the feeder
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7. rename the new layer Foliage using the layer thumbnail’s 
textbox.

8. Click the Clone stamp tool icon (or press s on your keyboard). 
make sure the sample all layers option is checked.

9. select the soft, round brush with a 150-pixel diameter from the 
presets.

10. use the Clone stamp tool to blend the foliage and cover up 
any obvious gaps, repeating patterns, etc. it should resemble 
the example shown in Figure 8-3. make sure no excess image 
data is covering the bird’s body—if it is, use the eraser tool to 
remove it.

Figure 8-2. Move the copied image data of the foliage over the feeder
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11. Click the background layer to make it active.

12. Click the lasso tool icon (or press l on your keyboard) and use 
the same Feather radius setting as before.

13. make a selection around some of the foliage just above the 
bird’s back (Figure 8-4).

Figure 8-4. Make a selection just above the bird as shown

Figure 8-3. Use the Clone Stamp tool to blend and cover up any gaps
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14. Copy (edit ➤ Copy) and paste (edit ➤ paste) the selected area 
to a new layer.

15. rename the new layer Foliage 2 using the layer thumbnail’s 
box.

16. use the move tool to position the layer above the head, then use 
the Free Transform command (edit ➤ Free Transform) to rotate 
the layer slightly counter-clockwise (Figure 8-5).

17. Click the move tool icon, then move the copied image data 
over the post—some of it will need to slightly cover the bird to 
completely cover the post.

18. Click the eraser tool icon (or press e on your keyboard) and 
remove the overlapping image data (Figure 8-6).

Figure 8-5. Rotate the layer slightly counter-clockwise
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19. use the Clone stamp tool to blend the foliage image data in 
with its surroundings (Figure 8-7). Be sure to sample often from 
various areas to avoid repeating patterns.

Figure 8-6. Use the Eraser tool to remove the excess image data

Figure 8-7. Use the Clone Stamp tool to blend the foliage in with the surroundings
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Figure 8-8 shows the before and after comparison. When you’re finished, either close 
the image without saving or save it as a PXD file for future reference. If you are a student, 
your teacher may instruct you to save the image with a certain name and in a certain 
location (such as a flash drive).

Adding Elements
I thought it might be nice to give our macaw friend a companion to keep him company. 
In this tutorial, we’ll learn how to add a bird from another photo.

TUTORIAL 18: ADDING ELEMENTS

The Addition of a Second Bird from a Different Source Image

To do this exercise, follow these steps:

1. Open the image titled Ch08_Macaw (Edited).jpg found in 
the Ch08 Practice Images folder (this version will resemble 
the result from the previous tutorial with the post and feeder 
removed).

2. Open the image titled Ch08_Cockatoo.jpg found in the Ch08 
Practice Images folder as a layer (layer ➤ Open image as 
layer).

3. The image of the cockatoo now exists as a layer over the 
background layer. using the Toggle layer settings dialog box, 
lower the opacity of the imported layer to 50%—this will help 
make it easier to move into position.

Figure 8-8. Before and after comparison
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4. rename the layer Cockatoo using the layer thumbnail’s textbox 
and move it into the position indicated in Figure 8-9 using the 
move tool.

5. restore the layer’s opacity to 100% using the Toggle layer 
settings dialog box.

6. add a layer mask using the Toggle layer settings dialog box 
(the Cockatoo layer will seem to disappear, but it’s still there).

 ■ Note layer masks are discussed in greater detail in The Beginner’s Guide to Layers 
pdF, which can be obtained from the source Code/downloads tab from this apress page: 
http://www.apress.com/9781484226971.

7. Click the Brush tool icon (or press B on your keyboard). select 
the hard, 200-pixel diameter brush from the presets.

Figure 8-9. Use the Move tool to position the Cockatoo layer as indicated here

http://www.apress.com/9781484226971
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8. Click the layer mask to make it active (indicated by a red 
border) and paint to reveal the cockatoo (Figure 8-10). don’t 
worry about the pixels outside of the bird being revealed—that 
will be dealt with shortly.

 ■ Note as you paint in the layer mask, each stroke is indicated by a green overlay. When 
the mouse button is released, the overlay disappears and the portion of the image the stroke 
covered is revealed.

9. after the cockatoo is revealed, we need to hide the fringe 
(excess) image data around it. Click the eraser tool icon  
(or press e on your keyboard).

10. select a small brush 30-50 pixels in diameter. set the hardness 
to 70%.

11. Zoom in using the navigator and work along the edge carefully 
to restore the mask, hiding the excess image data around the 
cockatoo (Figure 8-11). 

Figure 8-10. Paint in the layer mask to reveal the cockatoo
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12. after working along the entire edge, switch to a larger brush to 
remove the larger areas.

13. look over the entire layer closely to make sure there aren’t any 
stray (or missing) pixels.

Figure 8-12 shows the before and after comparison. When you’re finished, either 
close the image without saving or save it as a PXD file for future reference. If you are a 
student, your teacher may instruct you to save the image with a certain name and in a 
certain location (such as a flash drive).

Figure 8-11. Work along the edge carefully

Figure 8-12. Before and after comparison
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Background Replacement
Sometimes, images can be improved by using a different background. In the upcoming 
tutorial, we’ll replace a plain light background (which is actually a wall) and replace it 
with something more stylish.

In many cases, using a layer mask as we did in the previous tutorial will work fine. 
If the subject has a smooth outline, then it’s usually fairly easy to paint the subject into a 
new background and use the Eraser tool to remove the excess image data.

However, putting images of people on a different background can sometimes be 
challenging. For example, not everyone has straight, smooth hair and isolating curly hair 
can be difficult.

Fortunately, the method used in the upcoming lesson can deal with that issue easily. 
It might not work in every scenario, but it works well in high-contrast images with light 
backgrounds.

TUTORIAL 19: BACKGROUND REPLACEMENT

Replacing a Wall with a Studio Background

To do this exercise, follow these steps:

1. Open the image titled Ch08_Studio Background.jpg found in 
the Ch08 Practice Images folder.

2. Open the image titled Ch08_Portrait of Young Woman.jpg 
found in the Ch08 Practice Images folder as a layer (choose 
layer ➤ Open image as layer).

3. rename the layer Portrait using the layer thumbnail’s textbox.

4. Change the layer’s blending mode to darken using the Toggle 
layer settings (Figure 8-13). The lightest areas will become 
transparent, leaving the darkest portions of the image intact.
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5. duplicate the layer (layer ➤ duplicate layer) and change the 
blending mode to normal.

6. Click the lasso tool icon (or press l on your keyboard).

7. make a selection of the background, getting close to the young 
woman (Figure 8-14).

Figure 8-13. Change the Blending mode to Darken to make the background transparent 
and keep the dark portions intact
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8. Clear the pixels (edit ➤ Clear). press Control+d to deactivate 
the selection.

9. Click the eraser tool icon (or press e on your keyboard). select 
the soft, 150-pixel diameter brush from the presets.

10. starting on the left side, erase the fringe area of the background 
along the hair, as shown in Figure 8-15. This reveals the pixels 
of the underlying layer that remained intact when the blending 
mode was changed to darken in step 4.

Figure 8-14. Use the Lasso tool to select most of the background
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11. reduce the brush size to 30 pixels and set the hardness to 75% 
in the Tool Options dialog box, then work along the edge of the 
face and sweater (Figure 8-16).

 ■ Note as you work along the image with the eraser tool, precision isn’t quite as 
important in the darker areas since the underlying pixels are intact. however, in the white 
areas of the sweater, be sure to use care along the edge.

Figure 8-15. Use the Eraser tool to remove the fringe area of the background, revealing the 
intact pixels of the underlying layer
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Figure 8-16. Use a smaller brush to work along the face and sweater

12. Finish removing the fringe along the sweater on both sides 
(Figure 8-17).
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Figure 8-18 shows the before and after comparison. When you’re finished, either 
close the image without saving or save it as a PXD file for future reference. If you are a 
student, your teacher may instruct you to save the image with a certain name and in a 
certain location (such as a flash drive).

Figure 8-17. Finish removing the fringe area on the sweater
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Figure 8-18. Before and after comparison

If you had been working with the opposite situation in this tutorial (which would 
be light hair against a dark background), the layer named Portrait would be set to the 
Lighten blend mode (Figure 8-19).

Figure 8-19. For light hair against a dark background, set the layer to the Lighten  
blend mode
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Summary
This chapter described several techniques for removing unwanted elements, adding 
elements, and replacing backgrounds.

In the first tutorial, unwanted items were removed by borrowing surrounding portions 
of the image and using the Clone Stamp tool to help blend it in for a seamless edit.

Next, we added an image of a cockatoo to go along with the macaw by using a layer 
mask. Using the Brush tool, it was “painted” in, and the fringe (excess) image data was 
removed using the Eraser tool.

In the last tutorial, we replaced the background of the image of a young woman. 
By using a layer with the Darken blend mode, the curly hair was kept intact, making the 
process fairly easy.

The next chapter covers using some of the adjustments and filters to create some fun 
projects.
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CHAPTER 9

Artistic Effects Using 
Adjustments and Filters

Pixlr Editor is a useful tool for adding effects to images to achieve a variety of artistic 
results. In Chapter 3, we looked at each adjustment and filter to see what effect is 
produced. In this chapter, we’ll work with a few in the upcoming tutorials to see get a 
good idea of the editing potential they offer.

In this chapter, we’ll learn the following:

•	 Creating Shallow Depth-of-Field: In this part, we’ll use the 
Gaussian blur filter and the layer mask to emphasize the subject 
of an image.

•	 Creating a Partial Effect: In this tutorial, we’ll apply the Old Photo 
adjustment to part of the image while leaving the rest as is.

•	 Creating a Distressed Fence Mural: This part demonstrates how 
to use a combination of filters and layer blend modes to create a 
fence mural.

Creating Shallow Depth-of-Field
In this tutorial, we’ll learn how to put more emphasis on the macaw by digitally creating a 
shallow depth-of-field effect.

TUTORIAL 20: DEPTH-OF-FIELD TO EMPHASIZE THE 
SUBJECT

Using Gaussian Blur and the Layer Mask

To do this exercise, follow these steps:

1. Open the image titled Ch09_Macaw (For Effects).jpg found 
in the Ch09 Practice Images folder.

http://dx.doi.org/10.1007/978-1-4842-2698-8_3
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2. duplicate the background layer twice (layer ➤ duplicate layer).

3. Click the first duplicate layer to make it active. rename it 
Blurred using the layer thumbnail’s textbox.

4. Open the gaussian blur dialog box (filter ➤ gaussian Blur). 
leave at the default radius setting of 50 (figure 9-1), then click 
OK to apply the filter.

Figure 9-1. Leave the Gaussian blur filter setting at 50, then click OK to apply

5. Click on the second (top) duplicate layer to make it active. 
rename it DOF (short for depth-of-field) using the layer 
thumbnail’s textbox.

6. add a layer mask using the Toggle layer settings dialog (the 
dOf layer will seem to disappear, but it’s still there).

7. Click the zBrush tool icon (or press B on your keyboard). select 
the hard, 30-pixel diameter brush from the presets.

8. Using the slider, set the hardness value to 75 (figure 9-2).
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9. Click in the layer mask to make it active and paint along the 
edge of the macaw to apply the overlay (figure 9-3). Work in a 
series of short strokes (zoom in close as needed).

Figure 9-2. Set the hardness value to 75

Figure 9-3. Paint in the layer mask to apply the overlay along the edge
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10. Continue working all the way around—if you go outside of the 
edge, use the eraser tool to correct (figure 9-4).

Figure 9-4. The Eraser tool can be used to make corrections if you mistakenly go beyond 
the edge of the macaw

Figure 9-5. Increase the brush size to reveal the rest of the macaw in focus

11. Once you’ve gone all the way around the macaw, increase the 
Brush tool’s tip size to 100 and paint in the layer mask to reveal 
the rest of the macaw in focus (figure 9-5).
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Figure 9-6 shows the before and after comparison. This technique helps the subject 
stand out from the background. When finished, either close the image without saving or 
save it as a PXD file for future reference. If you are a student, your teacher may instruct you 
to save the image with a certain name and in a certain location (such as a flash drive).

Creating a Partial Effect
In this tutorial, we’ll work with the image of an old car. The Old Photo adjustment will be 
applied to background of the image, while revealing the rusty “patina” of the car.

TUTORIAL 21: CREATING A PARTIAL EFFECT

Applying the Old Photo Adjustment to Part of an Image

in the upcoming exercise, we’ll work with an image of an old car and applying the 
Old photo adjustment to portions of the image.

To do this exercise, follow these steps:

1. Open the image titled Ch09_Vintage Car.jpg found in the 
Ch09 Practice Images folder.

2. duplicate the background layer twice (layer ➤ duplicate 
layer). rename the first duplicate layer Old Photo using the 
layer thumbnail’s textbox.

3. rename the second duplicate (top) layer Partial Effect.

4. Click the layer named Old Photo to make it active. apply the 
Old photo adjustment (adjustment ➤ Old photo).

5. Click the layer named Partial Effect to make it active.

Figure 9-6. Before and after comparison
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6. add a layer mask using the Toggle layer settings dialog box 
(the Old Photo layer should be revealed).

7. Click the Brush tool icon (or press B on your keyboard). select 
the hard, 30-pixel diameter brush from the presets.

8. Using the slider, set the hardness value to 75.

9. paint in the layer mask around the edge of the car. Work around 
the windows (figure 9-7).

10. paint within the wheel hubs to reveal the rust (figure 9-8).

Figure 9-7. Work around the edge and the windows of the car

Figure 9-8. Work within the wheel hubs to reveal the rust
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11. select the 100-pixel diameter brush and work within the rest of 
the layer mask to reveal the rest of the car’s original “patina” 
(figure 9-9).

Figure 9-10 shows the before and after comparison. This technique helps create an 
interesting effect. When finished, either close the image without saving or save it as a 
PXD file for future reference. If you are a student, your teacher may instruct you to save the 
image with a certain name and in a certain location (such as a flash drive).

Creating a Distressed Fence Mural
In this tutorial, we’ll apply the image of a tiger to an old, wooden fence create the effect of 
a distressed mural.

Figure 9-9. Use a large brush to reveal the rest of the car's patina

Figure 9-10. Before and after comparison
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TUTORIAL 22: CREATING A DISTRESSED FENCE MURAL

Using A Combination of Filters and Blend Modes

To do this exercise, follow these steps:

1. Open the image titled Ch09_Wooden Fence.jpg found in the 
Ch09 Practice Images folder.

2. Open the image titled Ch09_Tiger.jpg found in the Ch09 
Practice Images folder as a layer (layer ➤ Open image as 
layer).

3. rename the layer Tiger using the layer thumbnail’s textbox.

4. Open the pastels dialog box (filter ➤ pastels). set the size to 4 
then click OK to apply the filter (figure 9-11).

5. Open the posterize adjustment dialog box (adjustment ➤ 
posterize). set the level to 4 (figure 9-12).

Figure 9-11. Set the Size setting to 4 in the Pastels filter dialog box, then click OK to apply 
the filter
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6. Using the Toggle layer settings, change the blend mode from 
normal to Overlay (figure 9-13). The tiger image has the 
appearance of being painted on the fence.

7. Click the eraser tool icon (or press e on your keyboard). select 
the hard, 30-pixel diameter brush from the presets.

8. Open the Brush presets dialog box, then click more.

Figure 9-12. Set the Level setting to 4 in the Posterize Adjustment dialog box, then click OK 
to apply the filter

Figure 9-13. The tiger image has the appearance of being painted on the fence
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9. Under the artistic heading, click the option labeled Dirt–2mb 
then click add (figure 9-14). These brushes will now be loaded 
into the Brush Options dialog box.

10. select the 950-pixel wide brush indicated in figure 9-15.

Figure 9-14. Under the default Artistic heading, click Dirt-2mb, followed by Add

Figure 9-15. Select the 950-pixel wide brush indicated in this figure
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11. position it in the upper-left corner and click. This will erase the 
pixels in the shape of the brush and create a weathered, worn 
effect, revealing the underlying wood of the fence (figure 9-16).

12. next, select the brush indicated (also 950 pixels wide), as 
shown in figure 9-17.

Figure 9-16. Click in the upper-left corner to erase the pixels as shown

Figure 9-17. Select the 950-pixel wide brush indicated in this figure
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13. position the brush in the right side as indicated in figure 9-18. 
Click to erase the pixels.

14. select the 1101-wide brush indicated in figure 9-19.

Figure 9-18. Click in the right side to erase the pixels as shown

Figure 9-19. Select the 1101-pixel wide brush indicated in this figure
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15. position approximately as shown in figure 9-20 and click to 
remove the pixels.

16. for the final brush, click the 1041-pixel wide brush indicated in 
figure 9-21.

17. position most of the brush in the lower-left corner, as indicated 
in figure 9-22. Click to remove the pixels.

Figure 9-20. Click in the area indicated in this figure to remove the pixels

Figure 9-21. Select the 1041-pixel wide brush indicated in this figure
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Figure 9-23 shows the final result—your version should be reasonably close to this 
example. When finished, either close the image without saving or save it as a PXD file for 
future reference. If you are a student, your teacher may instruct you to save the image with 
a certain name and in a certain location (such as a flash drive).

Figure 9-22. Click in the area indicated in this figure to remove the pixels

Figure 9-23. The final result should bear a close resemblance to this example
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Summary
This chapter described several techniques for using adjustments and filters for creating 
artistic effects.

The Gaussian blur filter was used to create a shallow depth-of-field effect on the 
image of the Macaw, helping it to stand out from the background.

In the next tutorial, a partial effect was applied. The Old Photo adjustment is a good 
fit for the image, but by using a layer mask, the “patina” of the old car was maintained.

In the last tutorial, a “distressed” mural was created by applying the image of a 
tiger over a wooden fence and using a combination of the Pastels filter, the Posterize 
adjustment, the Overlay Blend mode. An assortment of brushes to erase certain areas of 
the image were used to give it a weathered appearance.

In the next chapter, we’ll use Pixlr Editor to create two graphic illustrations and a 
(fictitious) business card.
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CHAPTER 10

Creating Graphic 
Illustrations

Until now, we’ve used Pixlr Editor to work with photographic images. As you’ve 
undoubtedly learned, it’s a very capable tool for image editing. It’s also a capable tool 
for creating raster-based illustrations. In this chapter, we’ll tap into the “inner artist” and 
create a few digital drawings using Pixlr Editor. Here’s what we’ll cover:

•	 Creating a Night Sky Illustration: In this part, we’ll create an 
illustration of a star filled night sky with a crescent moon.

•	 Creating a Billiard Illustration: This part provides step-by-step 
instructions for creating an illustration of a billiard ball used in 
the game of pool.

•	 Creating a Business Card: In this final tutorial, we’ll create a 
business card for a fictitious consignment shop.

 ■ Note Because you’ll be creating most of the images from scratch in this chapter, you 
don’t need to be concerned with duplicating the examples 100%. The goal of these tutorials 
is to acquaint the reader with techniques for creating images. Of course, it’s a good idea to 
strive to get as close as possible.

Creating a Night Sky Illustration
In this tutorial, we’ll learn how to draw a sky with stars (using the Brush tool) and a partial 
moon. Because creating the stars is a rapid process, your illustration will likely have a 
different star pattern than those shown in the upcoming figure(s).
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TUTORIAL 23: CREATING A NIGHT SKY

Drawing a Star-Filled Night Sky Using Pixlr Editor

To do this exercise, follow these steps:

1. Create a new image using the default presets. name the image 
Night Sky (or use a name of your choosing).

2. Click the gradient tool icon.

3. Click the gradient icon in the Tool Options bar—after the Options 
window opens, select the blue-to-black gradient (Figure 10-1).

4. Click and drag vertically from bottom to top on the Background 
layer to make a sky ranging from deep blue (in the lower 
portion) to black at the uppermost part (Figure 10-2).

Figure 10-1. After launching the options window, select the blue-to-black gradient
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5. Create a new layer (layer ➤ new layer) and rename it Moon 
using the layer thumbnail’s textbox.

6. Click the Marquee tool icon (or press M on your keyboard).

7. select the elliptical option, set the Constraint to aspect ratio, 
and set the Feather radius to 10.

8. On the layer named Moon, click and drag to make a circular 
selection about 220-240 pixels in diameter near the upper-right 
corner (Figure 10-3).

Figure 10-2. The gradient that will serve as the night sky color
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9. The next step is to fill the circular selection with a pale yellow 
color. Click in the set Main Color swatch to open the Color 
selector dialog box.

10. select a yellow hue using the numeric inputs: r-255, g-248, 
and B-122 (Figure 10-4). Click OK when you’re done.

Figure 10-3. Use the Marquee tool to make a circular selection where the moon will be

Figure 10-4. Launch the Color Selector dialog box and use the numeric settings shown to 
achieve a pale yellow
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11. Click the paint Bucket tool icon or press the letter g on your 
keyboard.

12. Fill the circular selection with the pale yellow.

13. Deactivate the selection (edit ➤ Deselect all).

14. We’ll now create the unlit portion of the moon. Duplicate the 
layer named Moon (layer ➤ Duplicate layer).

15. Turn the duplicate layer’s visibility off by clicking the option box 
to uncheck it.

16. Click on the original layer named Moon to make it active and 
invert the color (adjustment ➤ invert).

17. using Toggle layer settings, change the mode from normal to 
Multiply and lower the opacity to 20% (Figure 10-5).

18. Click the layer named Moon Copy and click the checkbox to 
make it visible again.

19. Click the Marquee tool icon (or press M on your keyboard).

20. select the elliptical option, set the Constraint to aspect ratio, 
and set the Feather radius to 10.

Figure 10-5. Use the Toggle layer settings to change the mode from Normal to Multiply and 
lower the opacity to 20%—this creates the unlit portion of the moon that’s barely visible
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21. Draw a circular selection overlapping the image of the moon 
(Figure 10-6).

22. remove the selected pixels (edit ➤ Clear), leaving a  
crescent-shaped moon (Figure 10-7).

Figure 10-6. Draw a circular selection overlapping the moon

Figure 10-7. Clear the selected pixels to leave a crescent shape
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23. Deactivate the selection (edit ➤ Deselect all).

24. Create a new layer (layer ➤ new layer). rename it Stars 
using the layer thumbnail’s textbox.

25. set the main color to white.

26. Click the Brush tool icon (or press B on your keyboard).

27. select the brush 5 pixels in diameter from the brush presets.

28. Make numerous small stars by clicking around the image 
(Figure 10-8).

29. select various other brushes to create stars of varying  
sizes—you can choose your own or use Figure 10-9 as a guide 
(shown larger than scale).

Figure 10-8. Use a 5-pixel diameter brush to make small stars

Figure 10-9. Guide to brush tip sizes to use for stars
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Your work should bear a reasonably close resemblance to the example shown in 
Figure 10-10—understandably, the star pattern in yours will likely differ. When you’re 
finished, either close the image without saving or save it as a PXD file for future reference. 
If you are a student, your teacher may instruct you to save the image with a certain name 
and in a certain location (such as a flash drive).

Creating a Billiard Illustration
In this tutorial, we’ll learn how to draw a billiard resting on a felt covered tabletop. There 
are quite a few steps involved in this tutorial, but it shouldn’t be too difficult to handle.

TUTORIAL 24: CREATING A BILLIARD

Drawing an Eight Ball Using Pixlr Editor

To do this exercise, follow these steps:

1. Create a new image using the default presets. name the image 
Billiard (or a name of your choosing).

2. Click in the set Main Color swatch to open the Color selector 
dialog box. select a green hue using the numeric inputs: r-0, 
g-99, and B-33 (Figure 10-11). Click OK when you’re done.

Figure 10-10. The final result should bear a reasonably close resemblance to this example
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3. Click the paint Bucket tool icon (or press g on your keyboard).

4. Click in the background layer to fill it with the green hue.

5. add noise to give it some texture (Filter ➤ noise). set the 
amount to 50 (Figure 10-12).

Figure 10-11. Launch the Color Selector dialog box and use the numeric settings shown to 
achieve the green hue that will be used

Figure 10-12. Using the Noise filter to create the appearance of texture
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6. To smooth it out and make it appear more like felt, open the 
gaussian Blur dialog box (Filter ➤ gaussian Blur). set the 
amount to 11 (Figure 10-13).

7. Create a new layer (layer ➤ new layer). rename the new layer 
Ball using the layer thumbnail’s textbox.

8. Click the Marquee tool icon (or press M on your keyboard).

9. select the elliptical option and set the Constraint to aspect ratio. 
Make sure the anti-alias box is checked.

10. Click and drag on the layer named Ball to create a circular 
selection until the diameter is about 334 pixels—it will display 
as W: 334 and h: 334 in the navigator palette (Figure 10-14).

Figure 10-13. Using the Gaussian Blur filter to smooth the noise out
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11. select black for the main color.

12. Click the paint Bucket tool icon or press the letter g on your 
keyboard.

13. Fill the selection with black.

14. Deactivate the selection (edit ➤ Deselect all).

15. Duplicate the layer (layer ➤ Duplicate layer) named Ball (this 
will be used to create the small, white circle to display the “8” 
character on).

16. rename the duplicate layer Inner Circle using the layer 
thumbnail’s textbox.

17. invert the color from black to white (adjustment ➤ invert).

18. select the Free Transform tool (edit ➤ Free Transform). hold 
the shift key and drag downward from the upper-left corner 
to maintain the aspect ratio and keep the circle centered. The 
white circle’s diameter should be about half that of the black 
circle’s (Figure 10-15).

Figure 10-14. Use the Marquee tool to make a circular selection
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19. select the Type tool icon (or press T on your keyboard).

20. Type the number 8 using a sans-serif font. (For this tutorial, 
abyssinica sil was used—if it isn’t installed on your computer 
simply choose a similar typeface.)

21. increase the size to 130 and change the style from regular 
to Bold (Figure 10-16). use the Move tool to center the “8” if 
necessary.

Figure 10-15. Creating the small white circle to display the “8” character

Figure 10-16. Use a bold, sans-serif font (size 130) for the digit
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22. Create a new layer (layer ➤ new layer) and rename it 
Reflection using the layer thumbnail’s textbox.

23. Click the Marquee tool icon (or press M on your keyboard).

24. select the elliptical option, set the Constraint to no restriction, 
and set the Feather radius to 15.

25. Click and drag on the layer named reflection to create a oval 
just above the white circle (Figure 10-17).

26. select white to use for the main color (if it isn’t already).

27. Click the paint Bucket tool icon (or press g on your keyboard).

28. Fill the selection with white.

29. Deactivate the selection (choose edit ➤ Deselect all).

30. lower the layer’s opacity to 75%. now the billiard has a nice 
shine (Figure 10-18).

Figure 10-17. Make an oval selection just above the white circle
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31. Create a new layer (layer ➤ new layer) and rename it Shadow 
using the layer thumbnail’s textbox. Move the layer below the 
one named Ball in the stack.

32. Click the Marquee tool icon or press M on your keyboard.

33. select the elliptical option (be sure to use the same settings as 
in step 24).

34. Click and drag on the layer named shadow to create a small 
oval just under the billiard (Figure 10-19).

Figure 10-18. The billiard now appears to have light reflected

Figure 10-19. Make an oval selection under the billiard to make a shadow
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35. select black to use for the main color.

36. Click the paint Bucket tool icon (or press g on your keyboard).

37. Fill the selection with black.

38. Deactivate the selection (choose edit ➤ Deselect all).

39. lower the layer’s opacity to 75%.

Your work should look very much like the example shown in shown in Figure 10-20. 
When you’re finished, either close the image without saving or save it as a PXD file for 
future reference. If you are a student, your teacher may instruct you to save the image with 
a certain name and in a certain location (such as a flash drive).

Creating a Business Card
Pixlr Editor is first and foremost an image editing application, not a page layout 
application. However, it can be used to create simple marketing materials such as 
business cards or small postcards in a pinch.

In this final tutorial, we’ll design a business card for a fictitious consignment shop.

 ■ Note  pixlr editor doesn’t have pre-installed fonts—instead it works with the ones 
already installed on your computer. For the purposes of the tutorial that follows, i’ll be using 
Times new roman and arial narrow. if those fonts aren’t installed on your computer, just 
choose the closest one(s) available.

Figure 10-20. The final result should look very much like this
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TUTORIAL 25: CREATING A BUSINESS CARD

Using Pixlr Editor to Design a Card for Fictitious Business

To do this exercise, follow these steps:

1. Create a new image using these dimensions—Width: 1050 X 
height: 600. These dimensions equal the size of a standard 
business card measuring 3.5" x 2" when printed at 300 Dpi.

 ■ Note printing service bureaus (both brick-and-mortar and online) usually require a 
slightly larger width and height to allow for trimming. When creating work you plan to have 
printed, check their requirements first.

2. Click the gradient tool icon.

3. Click the gradient icon in the Tool Options bar—after the 
Options window opens, select the light gray-to-white gradient 
(Figure 10-21).

Figure 10-21. After launching the Options window, select the light gray-to-white gradient



ChapTer 10 ■ CreaTing graphiC illusTraTiOns

221

4. Click and drag from top-left corner to the bottom-right corner 
on the Background layer (the same direction as shown in the 
swatch).

5. next, the silhouette of the woman will be placed on the 
background as a separate layer. To do this, open the  
Ch10_Silhouette in Dress.png file (layer ➤ Open image  
as layer).

6. rename the layer Figure using the layer thumbnail’s textbox.

7. using the Free Transform tool (edit ➤ Free Transform), reduce 
the size of the silhouette and position it in the area, as shown in 
Figure 10-22.

8. Click in the set Main Color swatch to open the Color selector 
dialog box.

9. select a reddish hue using the numeric inputs: r-135, g-23, 
and B-23 (Figure 10-23). Click OK when you’re done.

Figure 10-22. Position the silhouette as shown
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10. Click the Type tool icon (or press T on your keyboard).

11. Type Sally's Consignment Shop, as shown in Figure 10-24. 
use the Times new roman font (or something similar if it’s not 
installed on your computer). Make the size 80 and the style 
italic. Click OK when you’re done.

Figure 10-23. Launch the Color Selector dialog box and use the numeric settings shown to 
achieve the reddish hue that will be used for the text

Figure 10-24. Typing the fictitious business name using the Type tool
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12. Open the layer styles dialog box (layer ➤ layer styles) and 
click the Bevels option. This will give the main text a raised, 3D 
effect (Figure 10-25). Click OK when you’re done.

13. Open the Type tool again and type the company message below 
the name: “Gently loved women’s fashions for less” (Figure 10-26). 
use the Times new roman (or similar) font. Make the size 40 
and the style italic. Click OK when you’re done.

Figure 10-25. Using the Bevels style gives the text a raised, 3D effect
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14. Open the Type tool again and type the featured products in the 
center of the card: 

a wide variety of top-name dresses

a wide variety of unique, vintage dresses

gently worn shoes

Top name handbags

use the arial narrow (or similar) font. Make the size 28 and the 
style regular (Figure 10-27). Click OK when you’re done.

Figure 10-26. Typing the company message just under the name
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Figure 10-27. Typing the company message just under the name

15. Open the Type tool again and type this contact information along 
the bottom of the card:

sally lynn-Owner

123 Maple lane, suite 123 (Maple plaza)

anytown, usa

phone: (123) 123-1234

use the Times new roman (or similar) font. Make the size 40 and 
the style italic (Figure 10-28). Click OK when you’re done.
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16. use the Move tool to position each text layer as shown in 
Figure 10-29. The final result should be reasonably close. Of 
course, if font substitution was required, it will probably look 
somewhat different.

Figure 10-28. Typing the contact information along the bottom of the card

Figure 10-29. The completed (fictitious) business card
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When you’re finished, either close the image without saving or save it as a PXD file 
for future reference. If you are a student, your teacher may instruct you to save the image 
with a certain name and in a certain location (such as a flash drive).

Summary
Even though Pixlr Editor is designed primarily for editing photographic images, it can 
be used for creating pixel-based illustrations and for (to a limited degree) simple layouts 
such as business cards or postcards.

Conclusion
If you’ve completed all of the tutorials, congratulations! You did a great deal of work, and 
you’ve undoubtedly learned a great deal in the process. It’s my hope that this book helped 
you gain some valuable knowledge and skills that you can use from now on.

Just remember, being good at photo editing takes time and practice, so keep going...
and best wishes in your future endeavors.
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APPENDIX A

Additional Resources for 
Pixlr Editor

You’ve seen a lot of examples in this book using the Pixlr Editor. This appendix directs you 
to a few sites that may be helpful in your image editing pursuits.

Additional Image Editing Applications
This section lists a couple of other free applications offered by Autodesk that are fun and 
easy to use.

Pixlr Express

www.pixlr.com/express/

Pixlr Express is excellent for basic editing tasks (such as cropping or adjusting 
contrast). It also has tons of effects, overlays, borders, and more (see Figure A-1).

http://www.pixlr.com/express/
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Pixlr Mobile

www.pixlr.com/mobile

With Pixlr Mobile, you can crop, rotate, and fine-tune your pictures on your mobile 
device. It’s available from the App Store and Google Play.

Image Editing and Free Stock Images
If you’ve mastered the tutorials in this book, here are a few web sites that can provide you 
with images to help you hone your skills.

Retouch Pro

www.retouchpro.com

This web site (Figure A-2) contains tutorials on retouching and restoration. You must 
sign up for full access to the site, but it’s free to join. There are various challenges you can 
take part in to test your skills. Retouch Pro also has a friendly and supportive community.

Figure A-1. Pixlr Express offers basic editing functions, and lots of effects, overlays, and 
other fun options

http://www.pixlr.com/mobile
http://www.retouchpro.com/


APPENDIX A ■ ADDItIoNAl REsouRcEs foR PIXlR EDItoR

231

Pexels

www.pexels.com

This web site (Figure A-3) offers free stock images that can be used for just about any 
purpose (even commercial use) without attribution. The only limitation is that people in 
the photos should not be portrayed in a bad light.

Figure A-2. Retouch Pro is a useful web site to help hone your image editing skills

Figure A-3. Pexels is an excellent source for free stock images

Whitt’s Image Works Free Digital Portrait Backgrounds

www.whittartworks.com/backgrounds/id14.html

This web site sells digital portrait backgrounds as digital downloads. There are 
several free examples available for download throughout the site (see Figure A-4). These 
backgrounds are useful in image editing and restoration work and graphic design (be sure 
to read the terms of use on the homepage).

www.pexels.com
http://www.whittartworks.com/backgrounds/id14.html
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Figure A-4. There are several free digital backgrounds available from this web site
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steps, 212

Bitmap image (BMP) file, 11
Blemish touch up images, 159

comparison, 163
duplicate layer, 161–162
Spot Heal tool, 159–160
work downward, 161

Bloat tool (A), 45
Blur tool (R), 38
Brush tool (B)

digital paintings, 27
menu options, 29
subset, 29
wide assortment shapes and sizes, 28

Burn tool (N), 42
Business card/small postcards

Bevels style, 223
color selector dialog box, 222
final result, 226
font and text styles, 224–225
Free Transform tool, 221

Index
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image creation, 219
layer styles dialog box, 223
Move tool, 226
numeric inputs, 221
options window, 220
steps, 220
text style, 225
Type tool icon, 222–224

��������� C
Clone Stamp tool (S), 33
Color adjustments

balance
blue offset slider, 138
color cast, 137
comparison, 138
dialog box, 136

curves
Chillauto preset, 151
colder preset, 148
comparison, 146
cross process, 151
darken shadows, 150
decrease contrast, 150
default preset, 147
dialog box, 144
increase contrast, 149
invert preset, 148
middle eyedropper option, 145
nine presets, 151–152
Sponge tool, 145
Unsharp Mask filter, 146
warmer preset, 149

levels adjustment
black and white point sliders, 140
blue channel, 142
color channel, 139
comparison, 143
dialog box, 138
green channel, 141
histogram data option, 142–143
red channel option, 139

RGB color model and color  
channels, 135–136

Colorpicker tool (I), 47
Color Replace tool, 35
Composition

correcting images
bounding box, 109–110
Clone Stamp tool, 111

comparison, 112
triangular selection, 110
underlying layer, 111

Crop tool
background image, 103
Clone Stamp tool, 105
comparison, 106
Grid tool, 104
layer’s textbox, 104

image size-print size, 112–113
inkjet printer, 112
overview, 99
photos, 99–100
rule of thirds

horizon line, 101
intersecting points, 101
symmetry trumps, 102
vertical guideline, 102

straightening images
Clone Stamp tool, 108
comparison, 108
duplicate layer, 106
steps, 106

Crop tool (C), 20

��������� D
Dodge tool (O), 41

brick wall, 131
Draw tool, 36

��������� E, F
Elements

cockatoo layer, 178
comparison, 180
mask layer, 179
Move tool, 178
Navigator tool, 179
source image, 177
steps, 177

Eraser tool (E)
layered image, 30
menu bar option, 30
Paint Bucket tool (G), 30
removes image data, 29

��������� G
Gamma slider. See Mid point slider
Gradient tool

dialog box option, 32

Business card/small postcards (cont.)
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linear and radial gradient, 32–33
modes, 33
spread method, 33
transition creation, 32

Graphics Interchange Format (GIF), 11

��������� H
Hand tool (H), 49
Histogram, 120

��������� I
Image noise

close-up view, 168
comparison, 169
Denoise filter, 168

��������� J, K
Joint Photographic Experts  

Group (JPEG), 11

��������� L
Lasso tool (L), 24
Levels adjustment, 120

��������� M
Marquee tool (M)

anti-alias option, 23
aspect ratio, 23
dialog box, 23
domino graphics, 22
Feather tool option, 23

Menu bar
adjustment

automatic levels, 73
brightness and contrast, 70
color balance dialog box, 71
color lookup, 77–78
cross processing, 76
curves, 72
desaturate removes, 75
exposure, 73
functions, 70
hues and saturation, 70–71
invert function, 74
levels dialog box, 72
menu option, 69

old photo, 76
posterize, 77
sepia tone, 74
solarize inverts, 75
threshold converts, 77
vibrance, 71

edit menu
brush image, 60
cut option deletes pixels, 57
free distort, 59
invert selection, 59
numerous functions, 56–57
rotate, resize/reshape images, 58

file menu
close option, 56
exit prompts option, 56
formats, 55
image dialog box, 54
option, 54

filter
art poster, 88
box blur filter, 78
diffuse, 81
emboss, 90
engrave, 90
find edges, 91
Gaussian blur, 79
glamour glow, 86
halftone, 82
heat map, 88
hope, 87
kaleidoscope, 84
menu options, 78
Mimic HDR, 87
night vision, 89
noise, 80
pastels, 86
pixelate, 82
Pointinize, 83
polar coordinates, 84
scanlines, 81
tilt shift, 85
tri tone, 89
unsharp mask, 79
vignette, 85
water swirl option, 83

help menu, 94
image

canvas width and height, 61–62
crop selection, 64–65
flipped horizontally, 64
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functions, 61
numeric values, 61
option, 60
rotates, 62–64
size dialog box, 61

keyboard shortcuts, 53
language menu option, 92
layers

functions, 66
mask, 68–69
merge down, 66
open image, 66
options, 65
raster layer, 68
styles, 68
visible layers, 67

login/sign up menu, 95
view menu option, 91

Mid point slider, 122
Move tool (V), 21

��������� N, O
Night sky illustration

background layer, 206
blue-to-black gradient, 206
brushes, 211
color selector dialog box, 208
creation, 205
crescent-shaped moon, 210–211
diameter brush, 211
final result, 212
Marquee tool, 208
options window, 206
overlapping selection, 210
steps, 206
toggle layer, 209

��������� P, Q
Paint bucket tool (G), 30
Pencil tool, 26

dialog box options, 26
digital sketching and drawing, 26
line creation, 27

Photographic images
billiard resting, 212
business cards/small postcards, 219

digital drawings, 205
night sky illustration (see Night sky 

illustration)
Photoshop Document (PSD), 12
Pinch tool (K), 46
Pixlr Document (PXD), 11
Pixlr Editor

file format options, 17
image editing, 3
launch, 3
opening images

copy image address, 13–14
edit image, 14–15
folder image, 13
image creation, 12
paste image address, 14
steps, 13

pixel-based (raster) image
close magnification, 8–9
graphics creation tool, 10
image file formats, 11
vector-based image, 9–10

saving images, 15
start screen, 4
workspace, 5

advertisements, 8
history palette, 7–8
layers palette, 6–7
navigator palette, 6
steps, 5

Portable Network Graphics (PNG), 11

��������� R
Red eye correction

Brush tool, 158
Burn tool, 155
color selector dialog box, 157
comparison, 159
Dodge tool, 156
duplicate layer, 154
Reduction tool, 153

Red Eye Reduction tool, 43
Remove unwanted elements, 171

Clone Stamp tool, 174, 176
comparison, 177
counter-clockwise layer, 175
Eraser tool, 175–176
Lasso tool, 172

Menu bar (cont.)
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move image, 173
selection, 174
steps, 171

��������� S
Scratches and damage repairs, 163

Clone Stamp tool, 163, 166–167
comparison, 167
process working upward, 166
puncture marks shown, 164
Spot Heal tool, 163, 165

Sharpen tool (Y), 38
Smudge tool (U), 39
Sponge tool (P), 40
Spot Heal tool, 44

��������� T, U, V
Tagged Image File Format (TIFF), 11
Tonal problems, 115–116

brightness and contrast  
adjustment

dialog box, 117
tonal quality, 118

comparison, 121
correcting tonality, 120
correction

anchor point, 124
comparison, 125
contrast, 125
steps, 124

curves adjustment, 123
Dodge and Burn tools

brick wall, 131
comparison, 133
hazy portion image, 132

exposure correction and  
adjustment, 118

comparison, 123
slight exposure  

correction, 122
steps, 122

improve contrast, 121
layer modes

comparison, 131
duplicate, 130
multiply layer mode, 129

normal screen, 130
slightly overexposed image, 128

levels adjustment, 120
mid point slider, 122
partial exposure correction, 126

adjustment, 127
anchor point, 126
bow shape, 127
comparison, 127

Tools, 19
Bloat tool (A), 45
Blur tool (R), 38
Brush tool (B), 27
Burn tool (N), 42
Clone Stamp tool (S), 33
Colorpicker tool (I), 47
Color Replace tool, 35
Crop tool, 20
Dodge tool (O), 41
Draw tool, 36
Eraser tool (E), 29
Gradient tool, 32
Hand tool (H), 49
Lasso tool (L), 24
Marquee tool (M), 22
Move tool (V), 21
options, 19
Pencil tool, 26
Pinch tool (K), 46
purpose and functions, 19
Red Eye Reduction tool, 43
set main color, 51
Sharpen tool (Y), 38
shortcuts, 19
Smudge tool (U), 39
Sponge tool (P), 40
Spot heal tool, 44
Type tool (T), 48
Wand tool (W), 25
Zoom tool (Z), 50

��������� W, X, Y
Wand tool (W), 25

��������� Z
Zoom tool (Z), 50
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